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C H A P T E R 1
Review the Cisco DNA Center Appliance
Features

• Appliance Hardware Specifications, on page 1
• Front and Rear Panels, on page 2
• Physical Specifications, on page 8
• Environmental Specifications, on page 9
• Power Specifications, on page 10
• 10 Gigabit Ethernet Switches, on page 11

Appliance Hardware Specifications
Cisco supplies Cisco Digital Network Architecture (DNA) Center in the form of a rack-mountable, physical
appliance. The first-generation Cisco DNA Center appliance (Cisco part number DN1-HW-APL) consists of
a Cisco Unified Computing System (UCS) C220 M4 small form factor (SFF) chassis, with the addition of a
Virtual Interface Card (VIC) 1227 in the mLOM slot. The Cisco DNA Center software image is preinstalled
on the appliance, but must be configured for use.

The following table summarizes the appliance's hardware specifications.

DescriptionFeature

One rack-unit (1RU) chassisChassis

Two 22-core Intel Xeon E5-2699 v4 2.20 GHz processorsProcessors

Eight 32-GB DDR4 2400 MHz registered DIMMs (RDIMMs)Memory

• Six 1.9-TB, 2.5-inch Enterprise Value 6G SATA solid state drives (SSDs)

• Two 480-GB, 2.5-inch Enterprise Value 12G SATA SSDs

Storage

• RAID 1 on slots 1 through 4

• RAID 10 on slots 5 through 8

Disk Management (RAID)
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DescriptionFeature

Supported connectors:

• Two 10-Gbps Ethernet ports on the Cisco UCS VIC 1227

• One 1-Gbps Ethernet dedicated management port

• Two 1-Gbps BASE-T Ethernet LAN ports

The following connectors are available but not typically used in the day-to-day
operation of Cisco DNA Center:

• One RS-232 serial port (RJ-45 connector)

• One 15-pin VGA2 connector

• Two USB 3.0 connectors

• One front-panel KVMconnector that is usedwith the KVMcable, which provides
two USB 2.0, one VGA, and one serial (DB-9) connector

Network and Management I/O

• Two 770-W AC power supplies

• Redundant as 1+1

Power

Six hot-swappable fan modules for front-to-rear coolingCooling

Video Graphics Array (VGA) video resolution up to 1920 x 1200, 16 bpp at 60 Hz,
and up to 256 MB of video memory

Video

Front and Rear Panels
The following figures and tables describe the front and rear panels of the 44-core Cisco DNACenter appliance.
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Figure 1: Appliance Front Panel

DescriptionComponent

A total of eight drives are available on the appliance:

• Six 1.9 TB SATA SSD

• Two 480 GB SAS SSD

Each installed drive bay has a fault LED and an activity LED.

When the drive fault LED is:

• Off: The drive is operating properly.

• Amber: The drive has failed.

• Amber, blinking: The drive is rebuilding.

When the drive activity LED is:

• Off: There is no drive in the sled (no access, no fault).

• Green: The drive is ready.

• Green, blinking: The drive is reading or writing data.

1

Pull-out asset tag2

Operations sub-panel buttons and LEDs. LED states for these buttons and the conditions
they indicate are described in the following entries.

3
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DescriptionComponent

Power button/power status LED. When the LED is:

• Off: There is no AC power to the appliance.

• Amber: The appliance is in standby power mode. Power is supplied only to the Cisco
Integrated Management Controller (CIMC) and some motherboard functions.

• Green: The appliance is in main power mode. Power is supplied to all the server
components.

4

Unit identification button and LED. When the LED is:

• Blue: Unit identification is active.

• Off: Unit identification is inactive.

5

System status LED. When the LED is:

• Green: The appliance is running in a normal operating condition.

• Green, blinking: The appliance is performing system initialization and memory
checks.

• Amber, steady: The appliance is in a degraded operational state, which may be due
to one or more of the following causes:

• Power supply redundancy is lost.

• CPUs are mismatched.

• At least one CPU is faulty.

• At least one DIMM is faulty.

• At least one drive in a RAID configuration failed.

• Amber, blinking: The appliance is in a critical fault state, which may be due to one
or more of the following:

• Boot failed.

• Fatal CPU and/or bus error was detected.

• Server is in an over-temperature condition.

6

Fan status LED. When the LED is:

• Green: All fan modules are operating properly.

• Amber, steady: One fan module has failed.

• Amber, blinking: Critical fault, two or more fan modules have failed.

7
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DescriptionComponent

Temperature status LED. When the LED is:

• Green: The appliance is operating at normal temperature.

• Amber, steady: One or more temperature sensors have exceeded a warning threshold.

• Amber, blinking: One or more temperature sensors have exceeded a critical threshold.

8

Power supply status LED. When the LED is:

• Green: All power supplies are operating normally.

• Amber, steady: One or more power supplies are in a degraded operational state.

• Amber, blinking: One or more power supplies are in a critical fault state.

9

Network link activity LED. When the LED is:

• Green, blinking: One or more Ethernet LOM ports are link-active, with activity.

• Green: One or more Ethernet LOM ports are link-active, but there is no activity.

• Off: The Ethernet link is idle.

10

KVM connector. Used with a KVM cable that provides two USB 2.0, one VGA, and one
serial connector.

11

Figure 2: Appliance Rear Panel

DescriptionComponent

Grounding-lug hole (for DC power supplies)1

PCIe riser 1/slot 12

PCIe riser 2/slot 23
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DescriptionComponent

Power supplies (up to two: redundant as 1+1). Each power supply has a power supply
fault LED and an AC power LED.

When the fault LED is:

• Off: The power supply is operating normally.

• Amber, blinking: An event warning threshold has been reached, but the power
supply continues to operate.

• Amber, solid: A critical fault threshold has been reached, causing the power supply
to shut down (for example, a fan failure or an over-temperature condition).

When the AC Power LED is:

• Green, solid: AC power is OK, DC output is OK.

• Green, blinking: AC power is OK, DC output is not enabled.

• Off: There is no AC power to the power supply.

For more details, see Power Specifications.

4

10-Gbps Cluster Port (Port 2, enp10s0, Network Adapter 1): This is the second 10-Gbps
port on the Cisco Virtual Interface Card (VIC) 1227 in the appliance mLOM slot. The
rear panel labels it Port 2 and the Maglev Configuration wizard identifies it as enp10s0
and Network Adapter 1. Connect this port to a switch with connections to the other nodes
in the Cisco DNA Center cluster.

This port has a link status (ACT) LED and a link speed (LINK) LED.

When the link status LED is:

• Green, blinking: Traffic is present on the active link.

• Green: Link is active, but there is no traffic present.

• Off: No link is present.

When the link speed LED is:

• Green: Link speed is 10 Gbps.

• Amber: Link speed is 1 Gbps.

• Off: Link speed is 100 Mbps or less.

The enterprise and cluster ports must operate at 10 Gbps only.Note

5
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DescriptionComponent

10-Gbps Enterprise Port (Port 1, enp9s0, Network Adapter 4): This is the first 10-Gbps
port on the Cisco Virtual Interface Card (VIC) 1227 in the appliance mLOM slot. The
rear panel labels it Port 1 and the Maglev Configuration wizard identifies it as enp9s0
and Network Adapter 4. Connect this port to a switch with IP reachability to the
networking equipment that Cisco DNA Center will manage.

This port has a link status (ACT) LED and a link speed (LINK) LED.

When the link status LED is:

• Green, blinking: Traffic is present on the active link.

• Green: Link is active, but there is no traffic present.

• Off: No link is present.

When the speed LED is:

• Green: Link speed is 10 Gbps.

• Amber: Link speed is 1 Gbps.

• Off: Link speed is 100 Mbps or less.

The Cisco DNA Center appliance enterprise and cluster ports must operate
at 10 Gbps only.

Note

6

Two USB 3.0 ports7

1-Gbps CIMC Port (M): This is the embedded port to the right of the two USB ports and
to the left of the RJ45 serial port. The back panel labels it M and you assign an IP address
to it when you enable browser access to the appliance's CIMCGUI (see Enable Browser
Access to Cisco IntegratedManagement Controller). This port is reserved for out-of-band
(OOB) management of the Cisco DNA Center appliance chassis and software. Connect
this port to a switch that provides access to your dedicated OOB enterprise management
network.

This port has a link status LED and a link speed LED. When the link status LED is:

• Green, blinking: Traffic is present on the active link.

• Green: Link is active, but there is no traffic present.

• Off: No link is present.

When the speed LED is:

• Green: Link speed is 1 Gbps.

• Amber: Link speed is 100 Mbps.

• Off: Link speed is 10 Mbps or less.

8

Serial port (RJ-45 connector)9
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DescriptionComponent

1-Gbps Cisco DNA Center GUI Port (1, enp1s0f0, Network Adapter 2): This is the first
Intel i350 1Gb Ethernet controller port. It is embedded on the appliance motherboard.
The rear panel labels it 1 and the Maglev Configuration wizard identifies it as enp1s0f0
and Network Adapter 2. Connect this port to a switch that provides access to your
dedicated enterprise management network.

This port has a link status LED and a link speed LED. When the status LED is:

• Green, blinking: Traffic is present on the active link.

• Green: Link is active, but there is no traffic present.

• Off: No link is present.

When the speed LED is:

• Green: Link speed is 1 Gbps.

• Amber: Link speed is 100 Mbps.

• Off: Link speed is 10 Mbps or less.

10

1-Gbps Cloud Port (2, enp1s0f1, Network Adapter 3): This is the second embedded
1Gbps Ethernet controller port. The rear panel labels it 2 and the Maglev Configuration
wizard identifies it as enp1s0f1 and Network Adapter 3. This port is optional. It is used
for connecting to the Internet when it is not possible to do so via the 10-Gbps enterprise
port (Port 1, enp9s0, Network Adapter 4).

This port has a link status LED and a link speed LED. When the link status LED is:

• Green, blinking: Traffic is present on the active link.

• Green: Link is active, but there is no traffic.

• Off: No link is present.

When the speed LED is:

• Green: Link speed is 1 Gbps.

• Amber: Link speed is 100 Mbps.

• Off: Link speed is 10 Mbps or less.

11

VGA video port (DB-15). This panel area around this port is blue.12

Blue LED locator button13

Physical Specifications
The following table lists the physical specifications for the appliance.
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Table 1: Physical Specifications

SpecificationDescription

1.7 in. (4.32 cm)Height

16.89 in. (43.0 cm)

Including handles:

18.98 in. (48.2 cm)

Width

29.8 in. (75.6 cm)

Including handles:

30.98 in. (78.7 cm)

Depth (length)

3 in. (76 mm)Front Clearance

1 in. (25 mm)Side Clearance

6 in. (152 mm)Rear Clearance

37.9 lb. (17.2 kg)Maximum weight (fully loaded chassis)

Environmental Specifications
The following table lists the environmental specifications for the Cisco DNA Center appliance.

Table 2: Environmental Specifications

SpecificationDescription

41 to 95°F (5 to 35°C)

Derate the maximum temperature by 1°C for every
1000 ft. (305 meters) of altitude above sea level.

Temperature, operating

–40 to 149°F (–40 to 65°C)Temperature, nonoperating (when the appliance is
stored or transported)

10 to 90%, noncondensing at 82°F (28°C)Humidity (RH), operating

5 to 93% at 82°F (28°C)Humidity, nonoperating

0 to 10,000 ft. (0 to 3,000 m)Altitude, operating

0 to 40,000 ft. (0 to 12,192 m)Altitude, nonoperating (when the appliance is stored
or transported)

5.4Sound power level, measure A-weighted per ISO7779
LwAd (Bels), operation at 73°F (23°C)
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SpecificationDescription

37Sound pressure level, measure A-weighted per
ISO7779 LpAm (dBA), Operation at 73°F (23°C)

Power Specifications
The specifications for the two 770 W AC power supplies (Cisco part number UCSC-PSU1-770W) provided
with the Cisco DNA Center appliance are listed in the table below.

Table 3: AC Power Supply Specifications

SpecificationDescription

Nominal range: 100–120 VAC, 200–240 VAC

Range: 90–132 VAC, 180–264 VAC

AC input voltage

Nominal range: 50 to 60 Hz

(Range: 47–63 Hz)

AC input frequency

9.5 A at 100 VAC

4.5 A at 208 VAC

Maximum AC input current

950 VA at 100 VACMaximum input volt-amperes

770 W at 100–120 VACMaximum output power per PSU

15 A at 35° CMaximum inrush current

12 ms at 770 WMaximum hold-up time

12 VDCPower supply output voltage

12 VDCPower supply standby voltage

Climate Savers Platinum Efficiency (80Plus Platinum
certified)

Efficiency rating

RSP2Form factor

IEC320 C14Input connector

You can get more specific power information for the exact configuration of your appliance by using the Cisco
UCS Power Calculator: http://ucspowercalc.cisco.com

Note
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10 Gigabit Ethernet Switches
The following table lists the 10 Gigabit Ethernet Cisco switches that can currently be brought up from the
first-generation Cisco DNA Center appliance. This table will be updated as more switches are tested.

CommentCisco Part NumberCisco Switch

—N5K-C5672UPCisco Nexus 5672UP

—C6880-X-LECisco Catalyst 6880-X

Tested with the Cisco Nexus 7700
Switch Supervisor2 Enhanced
Module (Cisco part number
N77-SUP2E) installed.

N77-C7706Cisco Nexus 7700 (6-Slot)

In order for the remaining switches in this table to function properly, ensure that the following settings are
configured for both your switch and your Cisco DNA Center appliance:

• Default VLAN: Specify the same port number on your appliance and switch.

• VLAN Mode: Set Trunk mode.

See Steps 3 and 4 in Execute Preconfiguration Checks, on page 48.

—WS-C3850-48XS-SCisco Catalyst 3850-48XS-S

—WS-C4500X-32SFP+Cisco Catalyst 4500X-32 SFP+

—C9500-40XCisco Catalyst C9500-40X-E

—WS-C3650-48PQ-ECisco Catalyst 3650-48PQ-E
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C H A P T E R 2
Plan the Deployment

• Planning Workflow, on page 13
• Cisco DNA Center and Cisco Software-Defined Access, on page 14
• Interface Cable Connections, on page 14
• Required IP Addresses and Subnets, on page 17
• Required Internet URLs and Fully Qualified Domain Names, on page 20
• Provide Secure Access to the Internet, on page 23
• Required Network Ports, on page 23
• Required Ports and Protocols for Cisco Software-Defined Access, on page 25
• Required Configuration Information, on page 32
• Required First-Time Setup Information, on page 33

Planning Workflow
You must perform the following planning and information-gathering tasks before attempting to install,
configure, and set up your Cisco DNA Center appliance. After you complete these tasks, you can continue
by physically installing your appliance in the data center.

1. Review the recommended cabling and switching requirements for standalone and cluster installations.
For more information, see Interface Cable Connections.

2. Gather the IP addressing, subnetting, and other IP traffic information that you will apply during appliance
configuration. For more information, see Required IP Addresses and Subnets.

3. Prepare a solution for the required access to web-based resources. For more information, see Required
Internet URLs and Fully Qualified Domain Names and Provide Secure Access to the Internet.

4. Reconfigure your firewalls and security policies for Cisco DNA Center traffic. For more information, see
Required Network Ports. If you are using Cisco DNACenter to manage a Cisco Software-Defined Access
(SD-Access) network, also see Required Ports and Protocols for Cisco Software-Defined Access.

5. Gather the additional information used during appliance configuration and first-time setup. For more
information, see Required Configuration Information and Required First-Time Setup Information.

Cisco DNA Center First-Generation Appliance Installation Guide, Release 2.3.7
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Cisco DNA Center and Cisco Software-Defined Access
You can use Cisco DNA Center to manage any type of network, including networks that employ the Cisco
SD-Access fabric architecture. Cisco SD-Access transforms conventional networks into intent-based networks,
where business logic becomes a physical part of the network, making it easy to automate day-to-day tasks
such as configuration, provisioning, and troubleshooting. The Cisco SD-Access solution reduces the time
taken to adapt the network to business needs, improves issue resolutions, and reduces security-breach impacts.

A complete discussion of the Cisco SD-Access solution is outside the scope of this guide. Network architects
and administrators planning to implement a Cisco SD-Access fabric architecture for use with Cisco DNA
Center can find additional information and guidance from the following resources:

• For more information on how Cisco DNA Center leverages Cisco SD-Access to automate solutions that
are not possible with normal networking approaches and techniques, see Software Defined Access:
Enabling Intent-Based Networking.

• For guidance in using Cisco SD-Access access segmentation to enhance network security, see the
Software-Defined Access Segmentation Design Guide.

• For guidance on deploying SDA with Cisco DNA Center, see the Software-Defined Access Deployment
Guide.

• For more information on the digital network architecture that is the foundation of Cisco DNA Center
and the Cisco SD-Access solution, and the roles that other Cisco and third-party products and solutions
play in this innovative architecture, see the Cisco DNA Design Zone.

Interface Cable Connections
Connect the ports on the appliance to switches providing the following types of network access. At a minimum,
you must configure the Enterprise and Cluster port interfaces, as they are required for Cisco DNA Center
functionality.

• During appliance configuration, the Maglev Configuration wizard does not let you proceed until you
assign the Cluster Link option to an interface. For both single-node and three-node deployments in a
production environment, designate port enp10s0 as the Cluster Link on the first-generation Cisco DNA
Center appliance (Cisco part number DN1-HW-APL).

• Be aware that the interface marked as the Cluster Link cannot be changed after configuration completes.
Later, if you must change the interface marked as the Cluster Link, you are required to reimage the
appliance. (For a description of the tasks you need to complete in order to reimage your Cisco DNA
Center appliance, see Reimage the Appliance, on page 55.) With this in mind, we recommend that you
set up the Cluster Port with an IP address, so as to allow for expansion to a three-node cluster in the
future. Also, make sure that the cluster link interface is connected to a switch port and is in the UP state.

• If you plan to build multiple clusters, you must use a separate IP scheme for each cluster in order to
prevent cross-cluster interaction (which might corrupt the clusters).

Note
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• (Required) 10-Gbps Enterprise Port (Port 1, enp9s0, Network Adapter 4): This is the right-hand
port on the VIC 1227 card in the appliance mLOM slot. Its purpose is to enable Cisco DNA Center to
communicate with and manage your network. Connect this port to a switch with connections to the
enterprise network and configure one IP address with a subnet mask for the port.

• (Required) 10-Gbps Cluster Port (Port 2, enp10s0, Network Adapter 1): This is the left-hand port
on the VIC 1227 card in the appliance mLOM slot. Its purpose is to enable communications among the
primary and secondary nodes in a CiscoDNACenter cluster. Connect this port to a switch with connections
to the other nodes in the cluster and configure one IP address with a subnet mask for the port.

• (Optional) 1-Gbps Cisco DNA Center GUI Port (1, enp1s0f0, Network Adapter 2): This port provides
access to the Cisco DNA Center GUI. Its purpose is to enable users to use the software on the appliance.
Connect this port to a switch with connections to your enterprise management network, and configure
one IP address with a subnet mask for the port.

• (Optional) 1-Gbps Cloud Port (2, enp1s0f1, Network Adapter 3): This port is optional. Use it only
if you cannot connect the appliance to the Internet (including to your Internet proxy server) using the
10-Gbps enterprise port (Port 1, enp9s0, Network Adapter 4). If you need to use the cloud port, connect
it to a switch with connections to your Internet proxy server and configure an IP address with a subnet
mask for the port.

• (Optional, but strongly recommended) 1-Gbps CIMC Port (M): This port provides browser access
to the Cisco Integrated Management Controller (CIMC) out-of-band appliance management interface
and its GUI. Its purpose is to allow you to manage the appliance and its hardware. Connect this port to
a switch with connections to your enterprise management network and configure an IP address with a
subnet mask for the port.

The following figure shows the recommended connections for a single-node Cisco DNA Center cluster:

Figure 3: Recommended Cabling for Single-Node Cluster

The following figure shows the recommended connections for a three-node Cisco DNA Center cluster. All
but one of the connections for each node in the three-node cluster are the same as those for the single-node
cluster, and use the same ports. The exception is the Cluster Port (Port 2, enp10s0, Network Adapter 1), which
is required so that each host in the three-node cluster can communicate with the other hosts.
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15

Plan the Deployment
Interface Cable Connections



Figure 4: Recommended Cabling for Three-Node Cluster

For a short video presentation about the rear-panel ports and how they are used, see the first five minutes of
Unboxing Cisco DNA Center Appliance for Assurance and SD-Access (under the section "Get Started").

For more details on each of the ports, see the rear panel diagram and accompanying descriptions for your
appliance in Front and Rear Panels.

Multinode cluster deployments require all the member nodes to be in the same network and at the same site.
The appliance does not support distribution of nodes across multiple networks or sites.

Note

When cabling the 10-Gbps enterprise and cluster ports, please note that both ports support only the following
media types:

• SFP-10G-LR (Long range, SMF)

• SFP-H10GB-CU1M (Twinax cable, passive, 1 Meter)

• SFP-H10GB-CU3M (Twinax cable, passive, 3 Meters)

• SFP-H10GB-CU5M (Twinax cable, passive, 5 Meters)

• SFP-H10GB-ACU7M (Twinax cable, active, 7 Meters)
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Required IP Addresses and Subnets
Before beginning the installation, you must ensure that your network has sufficient IP addresses available to
assign to each of the appliance ports that you plan on using. Depending on whether you are installing the
appliance as a single-node cluster or as a primary or secondary node in a three-node cluster, you will need
the following appliance port (NIC) addresses:

• Enterprise Port Address (Required): One IP address with a subnet mask.

• Cluster Port Address (Required): One IP address with a subnet mask.

• Management Port Address (Optional): One IP address with a subnet mask.

• Cloud Port Address (Optional): One IP address with a subnet mask. This is an optional port, used only
when you cannot connect to the cloud using the Enterprise port. You do not need an IP address for the
Cloud port unless you must use it for this purpose.

• CIMC Port Address (Optional, but strongly recommended): One IP address with a subnet mask.

All of the IP addresses called for in these requirements must be valid IPv4 addresses with valid IPv4 netmasks.
Ensure that the addresses and their corresponding subnets do not overlap. Service communication issues can
result if they do.

Note

You will also need the following additional IP addresses and dedicated IP subnets, which are prompted for
and applied during configuration of the appliance:

1. Cluster Virtual IP Addresses: One virtual IP (VIP) address per configured network interface per cluster.
This requirement applies to three-node clusters and single-node clusters that are likely to be converted
into a three-node cluster in the future. You must supply a VIP for each network interface you configure.
Each VIP should be from the same subnet as the IP address of the corresponding configured interface.
There are four interfaces on each appliance: Enterprise, Cluster, Management, and Cloud. At a minimum,
you must configure the Enterprise and Cluster port interfaces, as they are required for Cisco DNA Center
functionality. An interface is considered configured if you supply an IP address for that interface, along
with a subnet mask and one or more associated gateways or static routes. If you skip an interface entirely
during configuration, that interface is considered as not configured.

Note the following:

• If you have a single-node setup and do not plan to convert it into a three-node cluster in the future,
you are not required to specify a virtual IP address. However, if you decide to do so, you must specify
a virtual IP address for every configured network interface (just as you would for a three-node cluster).

• If the intracluster link for a single-node cluster goes down, the VIP addresses associated with the
Management and Enterprise interfaces also go down. When this happens, Cisco DNA Center is
unusable until the intracluster link is restored (because the Software Image Management [SWIM]
and Cisco Identity Services Engine [ISE] integration is not operational and Cisco DNA Assurance
data is not displayed because information cannot be gathered from Network Data Platform [NDP]
collectors).

• Do not use a link-local or nonroutable IP address for the Enterprise or Management interface.
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2. Default Gateway IP Address: The IP address for your network's preferred default gateway. If no other
routes match the traffic, traffic will be routed through this IP address. Typically, you should assign the
default gateway to the interface in your network configuration that accesses the internet. For information
on security considerations to keep in mind when deploying Cisco DNA Center, see the Cisco Digital
Network Architecture Center Security Best Practices Guide.

3. DNS Server IP Addresses: The IP address for one or more of your network's preferred DNS servers.
During configuration, you can specify multiple DNS server IP addresses by entering them as a
space-separated list.

4. (Optional) Static Route Addresses: The IP addresses, subnet masks, and gateways for one or more static
routes. During configuration, you can specify multiple static-route IP addresses, netmasks, and gateways
by entering them as a space-separated list.

You can set one or more static routes for any interface on the appliance. You should supply static routes
when you want to route traffic in a specific direction other than the default gateway. Each of the interfaces
with static routes will be set as the device the traffic will be routed through in the IP route command table.
For this reason, it is important to match the static route directions with the interface though which the
traffic will be sent.

Static routes are not recommended in network device routing tables such as those used by switches and
routers. Dynamic routing protocols are better for this. However, you should add them where needed to
allow the appliance access to particular parts of the network that can be reached no other way.

5. NTP Server IP Addresses: The DNS-resolvable hostname, or IP address, for at least one Network Time
Protocol (NTP) server.

During configuration, you can specify multiple NTP server IP addresses/masks or hostnames by entering
them as a space-separated list. For a production deployment, we recommend that you configure a minimum
of three NTP servers.

You will specify these servers during pre-flight hardware synchronization and again during configuration
of the software on each appliance in the cluster. Time synchronization is critical to the accuracy of data
and coordination of processing across a multi-host cluster. Before deploying the appliance in production,
make sure that the time on the appliance system clock is current and that the Network Time Protocol
(NTP) servers you specified are keeping accurate time. If you are planning to integrate the appliance with
Cisco Identity Services Engine (ISE), you should also ensure that ISE is synchronizing with the same
NTP servers as the appliance.

6. Container Subnet: Identifies one dedicated IP subnet for the appliance to use in managing and getting
IP addresses for communications among its internal application services, such as Assurance, inventory
collection, and so on. By default, Cisco DNA Center configures a link-local subnet (169.254.32.0/20) for
this parameter, and we recommend that you use this subnet. If you choose to enter another subnet, ensure
that it does not conflict with or overlap any other subnet used by Cisco DNA Center's internal network
or any external network. Also ensure that the minimum size of the subnet is 21 bits. The subnet you specify
must conform with the IETF RFC 1918 and RFC 6598 specifications for private networks, which support
the following address ranges:

• 10.0.0.0/8

• 172.16.0.0/12

• 192.168.0.0/16

• 100.64.0.0/10
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For details, see RFC 1918, Address Allocation for Private Internets, and RFC 6598, IANA-Reserved IPv4
Prefix for Shared Address Space.

• Ensure that you specify a valid CIDR subnet. Otherwise, incorrect bits will be present in the 172.17.1.0/20
and 172.17.61.0/20 subnets.

• After configuration of your Cisco DNA Center appliance is completed, you cannot assign a different
subnet without first reimaging the appliance (see the "Reimage the Appliance" topic in the "Configure
the Appliance" chapter for more information).

Important

7. Cluster Subnet: Identifies one dedicated IP subnet for the appliance to use in managing and getting IPs
for communications among its infrastructure services, such as database access, the message bus, and so
on. By default, Cisco DNA Center configures a link-local subnet (169.254.48.0/20) for this parameter,
and we recommend that you use this subnet. If you choose to enter another subnet, ensure that it does not
conflict with or overlap any other subnet used by Cisco DNA Center's internal network or any external
network. Also ensure that the minimum size of the subnet is 21 bits. The subnet you specify must conform
with the IETF RFC 1918 and RFC 6598 specifications for private networks, which support the following
address ranges:

• 10.0.0.0/8

• 172.16.0.0/12

• 192.168.0.0/16

• 100.64.0.0/10

For details, see RFC 1918, Address Allocation for Private Internets, and RFC 6598, IANA-Reserved IPv4
Prefix for Shared Address Space.

If you were to specify 10.10.10.0/21 as your Container subnet, you could also specify a Cluster subnet of
10.0.8.0/21 since these two subnets do not overlap. Also note that the configuration wizard detects overlaps
(if any) between these subnets and prompts you to correct the overlap.

• Ensure that you specify a valid CIDR subnet. Otherwise, incorrect bits will be present in the 172.17.1.0/20
and 172.17.61.0/20 subnets.

• After configuration of your Cisco DNA Center appliance is completed, you cannot assign a different
subnet without first reimaging the appliance (see the "Reimage the Appliance" topic in the "Configure
the Appliance" chapter for more information).

Important

The recommended total IP address space for the two Container and Cluster subnets contains 4,096 addresses,
broken down into two /21 subnets of 2,048 addresses each. The two /21 subnets must not overlap. Cisco DNA
Center's internal services require a dedicated set of IP addresses to operate (a requirement of the Cisco DNA
Center microservice architecture. To accommodate this requirement, you must allocate two dedicated subnets
per Cisco DNA Center system.

One reason the appliance requires this amount of address space is to maintain system performance. Because
it uses internal routing and tunneling technologies for east-west (inter-node) communications, using overlapping
address spaces would force the appliance to run Virtual Routing and Forwarding FIBs internally. This would
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lead to multiple encaps/decaps for packets going from one service to another, causing high internal latency
at a very low level, with cascading impacts at higher layers.

Another reason is the CiscoDNACenter Kubernetes-based service containerization architecture. Each appliance
uses the IP addresses in this space per Kubernetes K8 node. Multiple nodes can make up a single service.
Currently, Cisco DNA Center supports more than 100 services, each requiring several IP addresses, and new
features and corresponding services are being added all the time. The address space requirement is purposely
kept large at the start to ensure that Cisco can add new services and features without either running out of IPs
or requiring customers to reallocate contiguous address spaces simply to upgrade their systems.

The services supported over these subnets are also enabled at Layer 3. The Cluster space, in particular, carries
data between application and infrastructure services, and is heavily used.

The RFC 1918 and RFC 6598 requirement is because of the requirement by Cisco DNA Center to download
packages and updates from the cloud. If the selected IP address ranges do not conform with RFC 1918 and
RFC 6598, this can quickly lead to problems with public IP address overlaps.

Required Internet URLs and Fully Qualified Domain Names
The appliance requires secure access to the following table of URLs and Fully Qualified Domain Names
(FQDNs).

The table describes the features that make use of each URL and FQDN. You must configure either your
network firewall or a proxy server so that IP traffic can travel to and from the appliance and these resources.
If you cannot provide this access for any listed URL and FQDN, the associated features will be impaired or
inoperable.

For more on requirements for proxy access to the internet, see Provide Secure Access to the Internet.

Table 4: Required URLs and FQDN Access

...Cisco DNA Center must access these URLs and FQDNsIn order to...

Recommended: *.ciscoconnectdna.com:4431

Customers who want to avoid wildcards can specify these URLs instead:

• https://www.ciscoconnectdna.com

• https://cdn.ciscoconnectdna.com

• https://registry.ciscoconnectdna.com

• https://registry-cdn.ciscoconnectdna.com

Download updates to the system and application
package software; submit user feedback to the
product team.

• https://*.ciscoconnectdna.com/*

• *.cloudfront.net

• *.tesseractcloud.com

Cisco DNA Center update package.
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...Cisco DNA Center must access these URLs and FQDNsIn order to...

• https://apx.cisco.com

• https://cloudsso.cisco.com/as/token.oauth2

• https://*.cisco.com/*

• https://download-ssc.cisco.com/

Smart Account and SWIM software downloads.

https://dnaservices.cisco.comAuthenticate with the cloud domain.

• *.awsglobalaccelerator.com

• api.thousandeyes.com

Integrate with ThousandEyes.

*.amazonaws.comManage Cisco Enterprise Network Function
Virtualization Infrastructure Software (NFVIS)
devices.

https://data.pendo.ioCollect product usage telemetry.

https://api-cx.cisco.comAllowAPI calls to enable access to Cisco CXCloud
Success Tracks. Otherwise, the enhancementsmade
to extended configuration-based scanning for the
Security Advisories, Bug Identifier, and EOX
features that Machine Reasoning Engine (MRE)
supports will not operate as expected.

• http://analytics.webexapis.com

• https://webexapis.com

Integrate with Webex.

https://dnacenter.uservoice.comUser feedback.

Recommended: *.meraki.com:443

Customers who want to avoid wildcards can specify these URLs instead:

• dashboard.meraki.com:443

• api.meraki.com:443

• n63.meraki.com:443

Integrate with Cisco Meraki.

• http://validation.identrust.com

• http://commercial.ocsp.identrust.com

These URLs should be reachable both directly and through the
proxy server that's configured for Cisco DNA Center.

Note

Check SSL/TLS certificate revocation status using
OCSP/CRL.

wss://prod.radkit-cloud.cisco.com:443Allow Cisco authorized specialists to collect
troubleshooting data when Cisco DNA Center
Remote Support functionality is enabled.
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...Cisco DNA Center must access these URLs and FQDNsIn order to...

*.cisco.com:443

Customers who want to avoid wildcards can specify these URLs instead:

• software.cisco.com

• cloudsso.cisco.com

• cloudsso1.cisco.com

• cloudsso2.cisco.com

• apiconsole.cisco.com

• api.cisco.com

• apx.cisco.com

• sso.cisco.com

• apmx-prod1-vip.cisco.com

• apmx-prod2-vip.cisco.com

• tools.cisco.com

• tools1.cisco.com

• tools2.cisco.com

• smartreceiver.cisco.com

Integrate with cisco.com and Cisco Smart Licensing.

prod.sdavc-cloud-api.com:443Connect to the Network-Based Application
Recognition (NBAR) cloud.

• www.mapbox.com

• *.tiles.mapbox.com/* :443. For a proxy, the destination is
*.tiles.mapbox.com/*

Render accurate information in site and location
maps.

• https://api.use1.prd.kairos.ciscolabs.com (US East Region)

• https://api.euc1.prd.kairos.ciscolabs.com (EU Central Region)

For Cisco AI Network Analytics data collection,
configure your network or HTTP proxy to allow
outbound HTTPS (TCP 443) access to the cloud
hosts.

https://ec.walkme.comAccess a menu of interactive help flows that let you
complete specific tasks from the GUI.

https://swapi.cisco.comAccess the licensing service.

• https://dnaspaces.io

• https://dnaspaces.eu

• https://ciscospaces.sg

Integrate with Cisco Spaces.
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1 Cisco owns and maintains ciscoconnectdna.com and its subdomains. The Cisco Connect DNA infrastructure meets Cisco
Security and Trust guidelines and undergoes continuous security testing. This infrastructure is robust, with built-in load balancing
and automation capabilities, and is monitored and maintained by a cloud operations team to ensure 24x7x365 availability.

Provide Secure Access to the Internet
By default, the appliance is configured to access the internet in order to download software updates, licenses,
and device software, as well as provide up-to-date map information, user feedback, and so on. Providing
internet connections for these purposes is a mandatory requirement.

Using an HTTPS proxy server is a reliable way to access remote URLs securely. We recommend that you
use an HTTPS proxy server to provide the appliance with the access it needs to the URLs listed in Required
Internet URLs and Fully Qualified Domain Names. During appliance installation, you are prompted to enter
the URL and port number of the proxy server you want to use for this purpose, along with the proxy's login
credentials (if the proxy requires them).

As of this release, the appliance supports communication with proxy servers over HTTP only. You can place
the HTTPS proxy server anywhere within your network. The proxy server communicates with the internet
using HTTPS, while the appliance communicates with the proxy server via HTTP. Therefore, we recommend
that you specify the proxy's HTTP port when configuring the proxy during appliance configuration.

If you need to change the proxy setting after configuration, you can do so using the GUI.

Required Network Ports
The following tables list the well-known network service ports that the appliance uses. You must ensure that
these ports are open for traffic flows to and from the appliance, whether you open them using firewall settings
or a proxy gateway.

Additional ports, protocols, and types of traffic must be accommodated if you are deploying the appliance in
a network that employs SDA infrastructure. For details, see Required Ports and Protocols for Cisco
Software-Defined Access.

For information on security considerations when deploying Cisco DNA Center, see the Cisco DNA Center
Security Best Practices Guide.

Note

Table 5: Ports: Incoming Traffic

Protocol (TCP or UDP)Permitted TrafficPort Number

TCPSSH22

UDPBOOTP67

TCPHTTP80

TCP and UDPNFS (used for Assurance backups)111

UDPNTP123
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Protocol (TCP or UDP)Permitted TrafficPort Number

UDPSNMP162

TCPHTTPS443

UDPSyslog514

TCP and UDPNFS (used for Assurance backups)2049

TCP

This port acts as the remote KVM
console redirect port. If Cisco IMC is
used during appliance configuration,
the port must be open until
configuration of the appliance is
complete.

Note

HTTPS2068

TCPSSH2222

TCPMulticast Domain Name System (mDNS)9991

TCP and UDPNFS (used for Assurance backups)20048

UDPApplication Visibility Service (used for
CBAR device communication)

21730

TCP and UDPNFS (used for Assurance backups)32767

Table 6: Ports: Outgoing Traffic

Protocol (TCP or UDP)Permitted TrafficPort Number

TCPSSH (to network devices)22

TCPTelnet (to network devices)23

UDPDNS53

TCPPort 80 can be used for an outgoing proxy configuration.

Other common ports (such as 8080) can also be used when a proxy is
configured using the Configuration wizard (if a proxy is already in use for
your network).

To access Cisco-supported certificates and trust pools, configure your network
to allow outgoing IP traffic from the appliance to the Cisco addresses listed
at:

https://www.cisco.com/security/pki/

80

UDPNTP123

UDPSNMP agent161
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Protocol (TCP or UDP)Permitted TrafficPort Number

TCPHTTPS443

TCPCisco ISE XMP for PxGrid5222, 8910

TCPCisco ISE ERS API traffic9060

Additionally, you can configure your network to allow outgoing IP traffic from the appliance to the Cisco
addresses at: https://www.cisco.com/security/pki/. The appliance uses the IP addresses listed at the above
URL to access Cisco-supported certificates and trust pools.

Note

Required Ports and Protocols for Cisco Software-Defined
Access

This topic details the ports, protocols, and types of traffic native to a typical Cisco SD-Access fabric deployment
that is similar to the one shown in the following figure.
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Figure 5: Cisco SD-Access Fabric Infrastructure

If you have implemented Cisco SD-Access in your network, use the information in the following tables to
plan firewall and security policies that secure your Cisco SD-Access infrastructure properly while providing
Cisco DNA Center with the access it requires to automate your network management.

Table 7: Cisco DNA Center Traffic

DescriptionDestinationDestination PortSourceSource
Port2

From Cisco DNA Center to DNS serverDNS ServerUDP 53Cisco DNA
Center

Any

FromCisco DNACenter to fabric switches' loopbacks
for SSH

Fabric underlayTCP 22Cisco DNA
Center

Any
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FromCisco DNACenter to fabric switches' loopbacks
for TELNET

Fabric underlayTCP 23Cisco DNA
Center

Any

FromCisco DNACenter to fabric switches' loopbacks
for SNMP device discovery

Fabric underlayUDP 161Cisco DNA
Center

Any

FromCisco DNACenter to fabric switches' loopbacks
for SNMP device discovery

Fabric underlayICMPCisco DNA
Center

ICMP

From Cisco DNA Center to fabric switches for
software upgrades (also to the internet if there is no
proxy)

Fabric underlayTCP 443Cisco DNA
Center

Any

From Cisco DNA Center to switches and routers for
NetFlow

Switches and routersUDP 6007Cisco DNA
Center

Any

From Cisco DNA Center to fabric switches for
Netconf (Cisco SD-Access embedded wireless)

Fabric underlayTCP 830Cisco DNA
Center

Any

From Cisco DNA Center to fabric switches for the
initial period during LAN automation

Fabric underlayUDP 123Cisco DNA
Center

UDP 123

From Cisco DNA Center to NTP serverNTP ServerUDP 123Cisco DNA
Center

Any

FromCisco DNACenter to CiscoWireless ControllerCisco Wireless
Controller

TCP 22, UDP
161

Cisco DNA
Center

Any

FromCisco DNACenter to CiscoWireless ControllerCisco Wireless
Controller

ICMPCisco DNA
Center

ICMP

Used for receiving traffic statistics and packet capture
data used by the Cisco DNA Assurance Intelligent
Capture (gRPC) feature.

Cisco DNA CenterTCP 32626APAny

2 Cluster, PKI, SFTP server, and proxy port traffic are not included in this table.

Table 8: Internet Connectivity Traffic

DescriptionDestinationDestination
Port

SourceSource
Port

Download Cisco DNACenter package
updates

registry.ciscoconnectdna.comTCP 443Cisco DNA CenterAny

Download Cisco DNACenter package
updates

www.ciscoconnectdna.comTCP 443Cisco DNA CenterAny

Download Cisco DNACenter package
updates

registry-cdn.ciscoconnectdna.comTCP 443Cisco DNA CenterAny

Download Cisco DNACenter package
updates

cdn.ciscoconnectdna.comTCP 443Cisco DNA CenterAny

Download device softwaresoftware.cisco.comTCP 443Cisco DNA CenterAny
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Validate Cisco.com and Smart Account
credentials

cloudsso.cisco.comTCP 443Cisco DNA CenterAny

Validate Cisco.com and Smart Account
credentials

cloudsso1.cisco.comTCP 443Cisco DNA CenterAny

Validate Cisco.com and Smart Account
credentials

cloudsso2.cisco.comTCP 443Cisco DNA CenterAny

CSSM Smart Licensing APIapiconsole.cisco.comTCP 443Cisco DNA CenterAny

Cisco.com credentials and Smart
Licensing

sso.cisco.comTCP 443Cisco DNA CenterAny

Cisco.com credentials and Smart
Licensing

api.cisco.comTCP 443Cisco DNA CenterAny

Cisco.com credentials and Smart
Licensing

apx.cisco.comTCP 443Cisco DNA CenterAny

Meraki integrationdashboard.meraki.comTCP 443Cisco DNA CenterAny

Meraki integrationapi.meraki.comTCP 443Cisco DNA CenterAny

Meraki integrationn63.meraki.comTCP 443Cisco DNA CenterAny

User feedback submissiondnacenter.uservoice.comTCP 443Cisco DNA CenterAny

Render maps in the browser (for access
through proxy; the destination is
*.tiles.mapbox.com/*)

*.tiles.mapbox.comTCP 443CiscoDNACenterAdmin
Client

Any

Maps and Cisco Wireless Controller
country code identification

www.mapbox.comTCP 443Cisco DNA CenterAny

Table 9: Cisco Software-Defined Access Fabric Underlay Traffic

DescriptionDestinationDestination PortSourceSource Port3

From fabric switches and routers to the DHCP
server for DHCP Relay packets initiated by the
fabric edge nodes.

DHCP serverUDP 67Fabric
underlay

UDP 68

From fabric switch and router loopback IPs to
Cisco DNA Center for PnP

Cisco DNA CenterTCP 80Fabric
underlay

Any

From fabric switch and router loopback IPs to
Cisco DNA Center for image upgrade

Cisco DNA CenterTCP 443Fabric
underlay

Any

From fabric switch and router loopback IPs to
Cisco DNA Center for SNMP Traps

Cisco DNA CenterUDP 162Fabric
underlay

Any

From fabric switches and routers to Cisco DNA
Assurance

Cisco DNA CenterUDP 514Fabric
underlay

Any

From fabric switches and routers to Cisco DNA
Center for NetFlow

Cisco DNA CenterUDP 6007Fabric
underlay

Any
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From fabric switches to Cisco DNA Center; used
when doing LAN automation

Cisco DNA CenterUDP 123Fabric
underlay

Any

From fabric switch and router loopbacks to Cisco
DNA Center for SNMP: device discovery

Cisco DNA CenterICMPFabric
underlay

ICMP

From fabric switch and router loopbacks to Cisco
DNA Center for SNMP: Device Discovery

Cisco DNA CenterAnyFabric
underlay

UDP 161

From fabric switches and routers to DNS server
for name resolution

DNS ServerUDP 53Fabric
underlay

Any

LISP-encapsulated control messagesFabric Routers and
Switches

TCP and UDP 4342Fabric
underlay

TCP and UDP
4342

LISP control-plane communicationsFabric Routers and
Switches

AnyFabric
underlay

TCP and UDP
4342

Fabric-encapsulated data packets (VXLAN-GPO)Fabric Routers and
Switches

UDP 4789Fabric
underlay

Any

From fabric switch and router loopback IPs to ISE
for RADIUS

ISEUDP
1645/1646/1812/1813

Fabric
underlay

Any

From fabric switches and routers to ISE for
troubleshooting

ISEICMPFabric
underlay

ICMP

From fabric switches to ISE for care-of address
(CoA)

ISEAnyFabric
underlay

UDP1700/3799

From fabric switch and router loopback IPs to the
NTP server

NTP ServerUDP 123Fabric
underlay

Any

From control-plane loopback IP to CiscoWireless
Controller for Fabric-enabled wireless

Cisco Wireless
Controller

UDP and TCP
4342/4343

control-planeAny

3 Border routing protocol, SPAN, profiling, and telemetry traffic are not included in this table.

Table 10: Cisco Wireless Controller Traffic

DescriptionDestinationDestination PortSourceSource Port

From Cisco Wireless Controller to an AP
subnet for CAPWAP

AP IP Address PoolAnyCisco Wireless ControllerUDP
5246/5247/5248

From Cisco Wireless Controller to APs
allowing ping for troubleshooting

AP IP Address PoolICMPCisco Wireless ControllerICMP

From Cisco Wireless Controller to Cisco
DNA Center for Assurance

Cisco DNA Center• TCP 443 (Cisco
AireOS
wireless
controllers)

• TCP 25103
(Cisco 9800
wireless
controllers)

Cisco Wireless ControllerAny
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From Cisco Wireless Controller to an AP
subnet for CAPWAP

AP IP Address PoolUDP 69/5246/5247
TCP 22

Cisco Wireless ControllerAny

From Cisco Wireless Controller to
control-plane loopback IP address

Control planeUDP and TCP
4342/4343

Cisco Wireless ControllerAny

From Cisco Wireless Controller to Cisco
DNA Center for device discovery

Cisco DNA CenterTCP 22Cisco Wireless ControllerAny

From Cisco Wireless Controller to Cisco
DNA Center for SNMP

Cisco DNA CenterAnyCisco Wireless ControllerUDP 161

From Cisco Wireless Controller to Cisco
DNA Center for SNMP traps

Cisco DNA CenterUDP 162Cisco Wireless ControllerAny

From Cisco Wireless Controller to Cisco
MSE and Spectrum Expert for NMSP

Cisco Mobility
Services Engine
(MSE) and Cisco
Spectrum Expert

TCP 16113Cisco Wireless ControllerAny

From wireless controllers to Cisco DNA
Center for NetFlow network telemetry

Cisco DNA CenterUDP 6007Cisco Wireless ControllerAny

From Cisco Wireless Controller to allow
ping for troubleshooting

Cisco DNA CenterICMPCisco Wireless ControllerICMP

Syslog (optional)Cisco Wireless
Controller

UDP 514Cisco Wireless Controller
and various syslog servers

Any

From Cisco Wireless Controller to DNS
server

DNS ServerUDP 53Cisco Wireless ControllerAny

FromCiscoWireless Controller to ISE for
Guest SSID web authorization

ISETCP 443Cisco Wireless ControllerAny

FromCiscoWireless Controller to ISE for
RADIUS authentication

ISEUDP 1645,1812Cisco Wireless ControllerAny

FromCiscoWireless Controller to ISE for
RADIUS accounting

ISEUDP 1646, 1813Cisco Wireless ControllerAny

FromCiscoWireless Controller to ISE for
RADIUS CoA

ISEUDP 1700, 3799Cisco Wireless ControllerAny

From Cisco Wireless Controller to ISE
ICMP for troubleshooting

ISEICMPCisco Wireless ControllerICMP

From Cisco Wireless Controller to NTP
server

NTP serverUDP 123Cisco Wireless ControllerAny

Table 11: Fabric-Enabled Wireless AP IP Address Pool Traffic

DescriptionDestinationDestination PortSourceSource
Port

From an AP IP Address pool to DHCP server.DHCP serverUDP 67AP IP Address
Pool

UDP 68
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From an AP IP Address pool to ICMP for
troubleshooting.

DHCP serverICMPAP IP Address
Pool

ICMP

Syslog—Destination configurable. Default is
255.255.255.255.

Various514AP IP Address
Pool

Any

From an AP IP Address pool to Cisco Wireless
Controller for CAPWAP.

Cisco Wireless
Controller

UDP
69/5246/5247/5248

AP IP Address
Pool

Any

From an AP IP Address pool to Cisco Wireless
Controller, allowing ping for troubleshooting.

Cisco Wireless
Controller

ICMPAP IP Address
Pool

ICMP

Table 12: Cisco ISE Traffic

DescriptionDestinationDestination
Port

SourceSource Port4

From ISE to border node for SGT Exchange Protocol
(SXP)

BorderTCP 64999ISEAny

From ISE to syslog server (Cisco DNA Center)Cisco DNA CenterUDP 514ISEAny

From ISE to fabric switches and routers for RADIUS
and authorization

Fabric underlayAnyISEUDP
1645/1646/1812/1813

From ISE to fabric switch and router loopback IP
addresses for RADIUS Change of Authorization
(CoA).

UDP port 3799 must also be open from ISE to the
wireless controller for CoA.

Fabric underlay, Cisco
Wireless Controller

UDP 1700/3799ISEAny

From ISE to fabric switches for troubleshootingFabric underlayICMPISEICMP

From ISE to NTP serverNTP ServerUDP 123ISEAny

From ISE to Cisco Wireless Controller for RADIUSCisco Wireless ControllerAnyISEUDP
1812/1645/1813/1646

From ISE to Cisco Wireless Controller for
troubleshooting

Cisco Wireless ControllerICMPISEICMP

4 Note: High availability and profiling traffic are not included in this table.

Table 13: DHCP Server Traffic

DescriptionDestinationDestination
Port

SourceSource
Port

From DHCP server to fabric APsAP IP Address PoolUDP 68DHCP
server

UDP 67

ICMP for troubleshooting: Fabric to DHCPAP IP Address PoolICMPDHCP
server

ICMP

From DHCP to fabric switches and routersFabric underlayUDP 68DHCP
server

UDP 67
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ICMP for troubleshooting: Fabric to DHCPFabric underlayICMPDHCP
server

ICMP

FromDHCP server to fabric switches and routersUser IP Address
Pool

UDP 68DHCP
server

UDP 67

ICMP for troubleshooting: User to DHCPUser IP Address
Pool

ICMPDHCP
server

ICMP

Table 14: NTP Server Traffic

DescriptionDestinationDestination
Port

SourceSource
Port

From NTP server to ISEISEAnyNTP
Server

UDP 123

From NTP server to Cisco DNA CenterCisco DNA CenterAnyNTP
Server

UDP 123

FromNTP server to fabric switch and router loopbackFabric underlayAnyNTP
Server

UDP 123

From NTP server to Cisco Wireless ControllerCisco Wireless
Controller

AnyNTP
Server

UDP 123

Table 15: DNS Traffic

DescriptionDestinationDestination
Port

SourceSource
Port

From DNS server to fabric switchesFabric underlayAnyDNS
Server

UDP 53

FromDNS server to CiscoWireless ControllerCisco Wireless
Controller

AnyDNS
Server

UDP 53

Required Configuration Information
During appliance configuration, you will be prompted for the following information, in addition to the Required
IP Addresses and Subnets:

• Linux Username: This is maglev. This username is the same on all the appliances in a cluster, including
the primary node and secondary nodes, and cannot be changed.

• Linux Password: Identifies the password for the Linux user named maglev. This password ensures
secure access to each appliance using the Linux command line. If required, you can assign a different
password for the maglev user that's configured on each appliance in a cluster.

You must create the Linux password because there is no default. The password must meet the following
requirements:

• Minimum length of eight characters.
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• Cannot contain a tab or a line break.

• Contains characters from at least three of the following categories:

• Uppercase letters (A–Z)

• Lowercase letters (a–z)

• Numbers (0–9)

• Special characters (for example, ! or #)

The Linux password is encrypted and hashed in the Cisco DNA Center database. If you are deploying a
multinode cluster, you will also be prompted to enter the primary node's Linux password on each of the
secondary nodes.

• Password Generation Seed (Optional): Instead of creating a Linux password, you can enter a seed
phrase and clickGenerate Password. TheMaglev Configurationwizard generates a random and secure
password using this seed phrase. You can further edit the generated password by using theAuto Generated
Password field.

• Administrator Passphrase: Identifies the password used for web access to Cisco DNA Center in a
cluster. This is the password for the superuser account admin, which you use to log in to Cisco DNA
Center for the first time (see #unique_23). You are prompted to change this password when you log in
for the first time.

You must create this password because there is no default. The Administrator Passphrase must meet the
same requirements as the Linux password, described earlier.

• CIMC User Password: Identifies the password used for access to the CIMC GUI. The factory default
is password, but you are prompted to change it when you first set up CIMC for access using a web
browser (see Enable Browser Access to Cisco Integrated Management Controller).

The CIMC user password must meet the same requirements as the Linux password described earlier. It
can be changed back to password only by a reset to factory defaults.

• Primary Node IP Address: Required only when you are installing secondary nodes in a cluster. This
is the IP address of the cluster port on the primary node (see Interface Cable Connections).

Required First-Time Setup Information
After you have configured your appliances, log in to Cisco DNA Center and complete the essential setup
tasks. During this first-time setup, you should have the following information:

• New Admin Superuser Password: You will be prompted to enter a new password for the Cisco DNA
Center admin super user. Resetting the super user password enhances operational security. This is
especially important if, for example, the enterprise staff who installed and configured the Cisco DNA
Center appliance is not a Cisco DNA Center user or administrator.

• Cisco.com Credentials: The Cisco.com user ID and password that your organization uses to register
software downloads and receive system communications through email.

• Cisco Smart Account Credentials: The Cisco.com Smart Account user ID and password your
organization uses for managing your device and software licenses.
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• IP Address Manager URL and Credentials: The host name, URL, admin user name, and admin
password of the third-party IP address manager (IPAM) server you plan to use with Cisco DNA Center.
This release supports InfoBlox and Bluecat.

• Proxy URL, Port, and Credentials: The URL (host name or IP address), port number, user name, and
user password of the proxy server you plan to use with Cisco DNA Center in order to get updates to the
Cisco DNA Center software, manage device licenses, and retrieve other downloadable content.

• Cisco DNA Center Users: User names, passwords, and privilege settings for the newCisco DNACenter
users you will be creating. We recommend that you always use one of these new user accounts for all
your normal Cisco DNA Center operations. Avoid using the admin super user account for activities,
except reconfiguring Cisco DNACenter and operations where super user privileges are explicitly required.

For details about how to launch and respond to the first-time setup wizard that prompts you for this information,
see Complete the Quick Start Workflow, on page 89.

You will also need the following information to complete the remaining setup tasks, which can be done after
your first login:

• ISE Server IP and Credentials: You will need the Cisco ISE server IP address and credentials,
administrative user name, and password. These are needed to log in to and configure your organization's
ISE server to share data with Cisco DNA Center, as explained in Integrate Cisco ISE with Cisco DNA
Center.

Installation of or upgrade to Cisco DNA Center checks to see if Cisco ISE is configured as an
authentication and policy (AAA) server. If the correct version of Cisco ISE is already configured, you
can start migrating group policy data from Cisco ISE to Cisco DNA Center.

If Cisco ISE is not configured, or if the required version of Cisco ISE is not present, Cisco DNA Center
installs, but Group Based Policy is disabled. You must install or upgrade Cisco ISE and connect it to
Cisco DNA Center. You can then start the data migration.

Cisco DNACenter data present in the previous version is preserved when you upgrade. The data migration
operation merges data from Cisco DNA Center and Cisco ISE. If the migration encounters a conflict,
preference is given to data from Cisco ISE.

If Cisco DNA Center becomes unavailable, and it is imperative to manage policies before Cisco DNA
Center becomes available once more, there is an option in Cisco ISE to override the Read-Only setting.
This allows you to make policy changes directly in Cisco ISE. After Cisco DNA Center is available
again, you must disable the Read-Only override on Cisco ISE, and re-synchronize the policy data on
Cisco DNA Center Group Based Access Control Settings page. Only use this option when absolutely
necessary, since changes made directly in Cisco ISE are not propagated to Cisco DNA Center.

• Authorization and Policy Server Information: If you are using Cisco ISE as your authentication and
policy server, you will need the same information listed in the previous bullet, plus the ISE CLI user
name, CLI password, server FQDN, a subscriber name (such as cdnac), the ISE SSH key (optional), the
protocol choice (RADIUS or TACACS), the authentication port, the accounting port, and retry and
timeout settings.

If you are using an authorization and policy server that is not Cisco ISE, you will need the server's IP
address, protocol choice (RADIUS or TACACS), authentication port, accounting port, and retry and
timeout settings.

This information is required to integrate Cisco DNA Center with your chosen authentication and policy
server, as explained in Configure Authentication and Policy Servers, on page 100.
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• SNMP Retry and Timeout Values: This is required to set up device polling andmonitoring, as explained
in Configure SNMP Properties.
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C H A P T E R 3
Install the Appliance

• Appliance Installation Workflow, on page 37
• Unpack and Inspect the Appliance, on page 37
• Review the Installation Warnings and Guidelines, on page 38
• Review the Rack Requirements, on page 39
• Connect and Power On the Appliance, on page 39
• Check the LEDs, on page 40

Appliance Installation Workflow
Complete the tasks described in this chapter to physically install your Cisco DNACenter appliance. Complete
these tasks for each appliance you want to install, and be sure to install all of the appliances before configuring
the primary node.

Unpack and Inspect the Appliance

When handling internal appliance components, wear an ESD strap and handle modules by the carrier edges
only.

Caution

Step 1 Remove the appliance from its cardboard container and save all the packaging material (in case the appliance requires
shipping in the future).

Step 2 Compare the shipment with the equipment list provided by your customer service representative. Verify that you have
all the items.

Step 3 Check for damage and report discrepancies or damage, if any, to your customer service representative immediately. Have
the following information ready:

• Invoice number of the shipper (see the packing slip)

• Model and serial number of the damaged unit

• Description of damage
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• Effect of damage on the installation

Review the Installation Warnings and Guidelines

To prevent the system from overheating, do not operate it in an area that exceeds the maximum
recommended ambient temperature of: 95°F (35°C). Statement 1047

Warning

The plug-socket combination must be accessible at all times, because it serves as the main disconnecting
device. Statement 1019

Warning

This product relies on the building’s installation for short-circuit (overcurrent) protection. Ensure that
the protective device is rated not greater than: 250 V, 15 A. Statement 1005

Warning

Installation of the equipment must comply with local and national electrical codes. Statement 1074Warning

To ensure proper airflow, it is necessary to rack the appliances using rail kits. Physically placing the units on
top of one another or stacking without the rail kits blocks the air vents on top of the appliances, which could
result in overheating, higher fan speeds, and higher power consumption. We recommend that you mount your
appliances on rail kits when you are installing them into the rack because these rails provide the minimal
spacing required between the appliances. No additional spacing between the appliances is required when you
mount the units using rail kits.

Caution

Avoid UPS models that use ferroresonant technology. These UPS models can become unstable with systems
such as the Cisco UCS, which can have substantial current-draw fluctuations because of fluctuating data traffic
patterns.

Caution

When you install an appliance, follow these guidelines:

• Plan your site configuration and prepare the site before installing the appliance. See the Cisco UCS Site
Preparation Guide for help with the recommended site planning and preparation tasks.

• Ensure that there is adequate space around the appliance to enable servicing, and for adequate airflow.
The airflow in this appliance is from front to back.

• Ensure that the site's air-conditioning meets the thermal requirements listed in Environmental
Specifications.
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• Ensure that the cabinet or rack meets the requirements listed in Review the Rack Requirements.

• Ensure that the site's power meets the requirements listed in Power Specifications. If available, use a
UPS to protect against power failures.

Review the Rack Requirements
For proper operation, the rack in which you install the appliance must meet the following requirements:

• A standard 19-in. (48.3-cm) wide, four-post EIA rack, with mounting posts that conform to English
universal hole spacing, per section 1 of ANSI/EIA-310-D-1992.

• The rack post holes can be square 0.38-in. (9.6 mm), round 0.28-in. (7.1 mm), #12-24 UNC, or #10-32
UNC when you use the supplied slide rails.

• The minimum vertical rack space per server must be one RU, equal to 1.75 in. (44.45 mm).

Connect and Power On the Appliance
This section describes how to power on the appliance and check that it is functional.

Step 1 Attach the supplied power cord to each power supply in the appliance and then attach the power cords to a grounded AC
power outlet. See Power Specifications, on page 10 for details.

Wait for approximately two minutes to let the appliance boot into standby power mode during the first boot up.

You can verify the power status by looking at the Power Status LED:

• Off—There is no AC power present in the appliance.

• Amber—The appliance is in standby power mode. Power is supplied only to the CIMC and some motherboard
functions.

• Green—The appliance is in main power mode. Power is supplied to all appliance components.

For more information on these and other appliance LEDs, see Front and Rear Panels.

Step 2 Connect a USB keyboard and VGAmonitor to the server, using the supplied KVM cable connected to the KVM connector
on the front panel. Alternatively, you can use the VGA and USB ports on the rear panel. You can only connect to one
VGA interface at a time.

What to do next

Continue by following the procedure described in Check the LEDs.
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Check the LEDs
After you have powered up the Cisco DNA Center appliance, check the state of the front-panel and rear-panel
LEDs and buttons to ensure it is functioning.

The following illustrations show the LEDs for a functional appliance after physical installation and first
power-up and before configuration.

Figure 6: Front Panel LEDs

Desired Status IndicatorLED

Drive Fault LEDs: Off.

Drive Activity LEDs: Green

1

Power Status: Green2

System Status: Green3

Fan Status: Green4

Temperature Status: Green5

Power Supply Status: Green6

Network Link Activity: Off7
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Figure 7: Rear Panel LEDs

Desired Status IndicatorLED

After initial power-up, all the ports should have their Link Status and Link Speed LEDs
showing as off, and their Power Status LED should be green.

After network settings are configured and tested using theMaglev ConfigurationWizard
(see Configure the Primary Node and Configure a Secondary Node), the Link Status,
Link Speed and Power Status LEDs for all cabled ports should be green. All uncabled
port LEDs should be unchanged.

1

Power Supply Fault LEDs: Off.

AC Power LEDs: Green

2

If you see LEDs with colors other than those shown above, you may have a problem condition. See Front and
Rear Panels for details on the likely causes of the status. Be sure to correct any problem conditions before
proceeding to configure the appliance.
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C H A P T E R 4
Prepare the Appliance for Configuration

• Preparation for Appliance Configuration Overview, on page 43
• Enable Browser Access to Cisco Integrated Management Controller, on page 43
• Execute Preconfiguration Checks, on page 48
• Reimage the Appliance, on page 55

Preparation for Appliance Configuration Overview
Before you can successfully configure your Cisco DNA Center appliance, first complete the following tasks:

1. Enable browser access to the appliance's Cisco IMC (see Enable Browser Access to Cisco Integrated
Management Controller).

2. Use Cisco IMC to check and adjust important hardware and switch settings (see Execute Preconfiguration
Checks).

3. Cisco DNA Center software is preinstalled on your appliance, but you may need to reinstall the software
in certain situations (such as before you change the current cluster link configuration). If this is the case,
you must also complete the tasks described in Reimage the Appliance.

If you do not need to reimage your appliance, proceed to Appliance Configuration Overview.Note

Enable Browser Access to Cisco Integrated Management
Controller

After installing the appliance, as described in Appliance InstallationWorkflow, use the Cisco IMC configuration
utility to assign an IP address and gateway to the appliance's CIMC port. This gives you access to the Cisco
IMC GUI, which you should use to configure the appliance.

After you complete the Cisco IMC setup, log in to Cisco IMC and run the tasks listed in Execute
Preconfiguration Checks to ensure correct configuration.
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To help ensure the security of your deployment, Cisco IMC prompts you to change the Cisco IMC user's
default password when you boot the appliance for the first time. To change the Cisco IMC user password
later, use the Cisco IMC GUI, as follows:

1. From the top-left corner of the GUI, click the Toggle Navigation icon ( ) and then choose Admin >
User Management.

The Local User Management tab should already be selected.

2. Check the check box for user 1, and then click Modify User.

The Modify User Details dialog box opens.

3. Check the Change Password check box.

4. Enter and confirm the new password, and then click Save.

Tip

Step 1 Access the appliance console by attaching either of the following:

• A KVM cable to the KVM connector on the appliance's front panel (component 12 on the front panel illustrated
in Front and Rear Panels)

• A keyboard andmonitor to the USB andVGA ports on the appliance's rear panel (components 7 and 12, respectively,
on the rear panel illustrated in Front and Rear Panels).

Step 2 Make sure that the appliance's power cord is plugged in and the power is on.
Step 3 Press the Power button on the front panel to boot the appliance.

The Cisco IMC configuration utility boot screen should be displayed, as shown below.
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Step 4 As soon as the boot screen is displayed, press F8 to perform Cisco IMC configuration.

The CIMC configuration utility displays the CIMC User Details screen, as shown below.

Step 5 Enter the default CIMC user password (the default on a new appliance is password) in the Enter current CIMC
Password field.

Step 6 Enter and confirm the new CIMC user password in the Enter new CIMC password and Re-Enter new CIMC
password fields.

When you press Enter after entering the new password in the Re-Enter new CIMC password field, the Cisco IMC
configuration utility displays the NIC Properties screen, as shown below.

Step 7 Perform the following actions:

• NIC mode: Select Dedicated.

• IP (Basic): Select IPV4.

• CIMC IP: Enter the IP address of the CIMC port.
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• Prefix/Subnet: Enter the subnet mask for the CIMC port IP address.

• Gateway: Enter the IP address of your preferred default gateway.

• Pref DNS Server: Enter the IP address of your preferred DNS server.

• NIC Redundancy: Select None.

Step 8 Press F1 to specify Additional settings.

The Cisco IMC configuration utility displays the Common Properties screen, as shown below.

Step 9 Perform the following actions:

• Hostname: Enter a hostname for CIMC on this appliance.

• Dynamic DNS: Uncheck the check box to disable this feature.

• Factory Defaults: Uncheck the check box to disable this feature.

• Default User (Basic): Leave these fields blank.

• Port Properties: Enter new settings or accept the defaults shown in these fields.

• Port Profiles: Uncheck the check box to disable this feature.

Step 10 Press F10 to save the settings.
Step 11 Press Escape to exit and reboot the appliance.
Step 12 After the settings are saved and the appliance finishes rebooting, open a compatible browser on a client machine with

access to the subnet on which the appliance is installed, and enter the following URL:
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https://CIMC_ip_address, where CIMC_ip_address is the Cisco IMC port IP address that you entered in
Step 7.

Your browser displays a main Cisco IMC GUI login window similar to the one shown below.

Step 13 Log in using the Cisco IMC user ID and password you set in Step 5.
If the login is successful, your browser displays a Cisco Integrated Management Controller Chassis Summary
window similar to the one shown below.
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Step 14 Confirm that this version of Cisco IMC is supported by the Cisco DNA Center release you're going to install:
a) Note the version listed in the Firmware Version field.
b) See the release notes for the Cisco DNA Center release you are installing. The “Supported Firmware” section

indicates the Cisco IMC version that your Cisco DNA Center release supports.
c) Do one of the following:

• If the right Cisco IMC version is installed, you can stop here.

• If you need to update your Cisco IMC version, see theCisco Host Upgrade Utility User Guide for instructions.

Execute Preconfiguration Checks
After installing the appliance (as described in Appliance Installation Workflow) and setting up access to the
Cisco IMC GUI (as described in Enable Browser Access to Cisco Integrated Management Controller), use
Cisco IMC to perform the following preconfiguration tasks, which help ensure correct configuration and
deployment:

1. Synchronize the appliance hardware with the Network Time Protocol (NTP) servers you use to manage
your network. These must be the same NTP servers whose hostnames or IPs you gathered for use when
planning your implementation, as explained in Required IP Addresses and Subnets. This is a critical task
that ensures that your Cisco DNA Center data is synchronized properly across the network.

2. Check that the appliance's 10-Gbps ports are enabled and properly configured for high throughput.

3. Reconfigure the switches connected to the 10-Gbps appliance ports to support higher throughput settings.

Cisco DNA Center First-Generation Appliance Installation Guide, Release 2.3.7
48

Prepare the Appliance for Configuration
Execute Preconfiguration Checks

https://www.cisco.com/c/en/us/support/cloud-systems-management/dna-center/products-release-notes-list.html
https://www.cisco.com/c/en/us/support/servers-unified-computing/ucs-c-series-rack-servers/products-user-guide-list.html


4. Reconfigure the switches connected to the 10-Gbps appliance ports to support oversize 802.1p frames.

Step 1 Log in to the appliance's Cisco IMC using the Cisco IMC IP address, user ID, and password you set in Enable Browser
Access to Cisco Integrated Management Controller.
If the login is successful, your browser displays the Cisco Integrated Management Controller Chassis Summary
window, as shown below.

Step 2 Synchronize the appliance's hardware with the Network Time Protocol (NTP) servers you use to manage your network,
as follows:

a) From the top-left corner of the Cisco IMC GUI, click the Toggle Navigation icon ( ).
b) From the Cisco IMC menu, select Admin > Networking, and then choose the NTP Setting tab.
c) Make sure that the NTP Enabled check box is checked and enter up to four NTP server host names or addresses in

the numbered Server fields, as shown in the example below.
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d) Click Save Changes. Cisco IMC validates your entries and then begins to synchronize the time on the appliance's
hardware with the time on the NTP servers.

Cisco IMC does not support NTP authentication.Note

Step 3 Next, check that the appliance NICs are configured to support high throughput, as follows:

a) If needed, click the icon to display the Cisco IMC menu.
b) From the Cisco IMC menu, select Chassis > Inventory > Cisco VIC Adapters. Verify that the Product ID

"UCSC-MLOM-CSC-02" is listed for the MLOM slot, as shown below:

c) Select >Compute >BIOS >Configure BIOS >Advanced. Verify that theReboot Host Immediately checkbox
is unchecked and note the location of the LOM and PCIe Slots Configuration dropdown.

Cisco DNA Center First-Generation Appliance Installation Guide, Release 2.3.7
50

Prepare the Appliance for Configuration
Execute Preconfiguration Checks



d) SelectLOM and PCIe Slots Configuration. Then, using the dropdown selectors, setPCIe Slot: MLOM OptionROM
to Enabled and PCIe Slot: MLOM Link Speed to Auto.

e) Click Save. You will be prompted to reboot the host. Click OK to continue instead of rebooting.
f) Select > Networking > Adapter Card MLOM > General. Take note of the MAC addresses for Port-0 and

Port-1 (shown in theExternal Ethernet Interfaces section at the bottom of the page). In theAdapter Card Properties
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section, use the dropdown selectors next to Port-0 and Port-1 to set the speed of both these ports to Auto, as shown
below. Then click Save Changes.

g) Click the vNICs tab and select eth0 from the vNICs dropdown. Use the selectors and fields to set these values for
eth0:

• VLAN Mode: Trunk

• MTU: 1500

• Default VLAN: 99 (Please note that "99" is only an example. You should enter the default VLAN value you
want your appliances and their connected uplink switch to use.)
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1500 is the minimum maximum transmission unit (MTU) size. You can improve throughput on the
10Gbps ports by entering any higher value, up to a maximum of 9000.

Tip

h) Click Save Changes. You will be prompted to reboot the host again. Click Cancel to continue instead of rebooting.
i) Select eth1 from the vNICS dropdown and set the values that you want your appliances and their connected uplink

switch to use.
j) When you are finished, click Save Changes. You will be prompted to reboot the host. This time, click OK to reboot

the appliance.
k) When the appliance is finished rebooting, log in to the Cisco IMC GUI again. Select > Networking > Adapter

Card MLOM > General > vNICs. Verify the accuracy of the vNIC MAC addresses and the MTU, VLAN and
VLAN Mode parameters you set earlier.

l) When you are finished: Click the Host Power menu at top right and select Power Cycle. Then click OK.

Step 4 Reconfigure your switches to match the high-throughput settings on the appliance, as follows:
a) Using a Secure Shell (SSH) client, log in to the switch to be configured and enter EXEC mode at the switch prompt.
b) Configure the switch port.
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On a Cisco Catalyst switch, enter the following commands. For example:
MySwitch#Config terminal
MySwitch(config)#interface tengigabitethernet 1/1/3
MySwitch(config-if)#switchport
MySwitch(config-if)#switchport mode trunk
MySwitch(config-if)#switchport trunk allowed vlan 99
MySwitch(config-if)#switchport voice vlan dot1p
MySwitch(config-if)#speed auto
MySwitch(config-if)#duplex full
MySwitch(config-if)#mtu 1500
MySwitch(config-if)#no shut
MySwitch(config-if)#end
MySwitch(config)#do copy running-config startup-config

On a Cisco Nexus switch, enter the following commands to disable Link Layer Discovery Protocol (LLDP) and
priority flow control (PFC). For example:
N7K2# configure terminal
N7K2(config)# interface eth 3/4
N7K2(config-if)# no priority-flow-control mode auto
N7K2(config-if)# no lldp transmit
N7K2(config-if)# no lldp receive

Note that these commands are examples only. When configuring your appliance's NICs, use the same VLAN ID and
MTU values you entered in Step 3 of this procedure. The values displayed for the link speed, duplex, and MTU
parameters are the defaults for your switch. Enter new values for these parameters only if you have changed the
defaults. You may, as with the appliance NICs, also set the MTU up to a maximum of 9000 for better throughput.

c) Run the show interface tengigabitethernet portID command and verify that the port is connected, running,
and has the correct MTU, duplex, and link-type settings in the command output. For example:
MySwitch#show interface tengigabitethernet 1/1/3
TenGigabitEthernet1/1/3 is up, line protocol is up (connected)
Hardware is Ten Gigabit Ethernet, address is XXXe.310.8000 (bia XXX.310.8000)
MTU 1500 bytes, BW 10000000 Kbit/sec, DLY 10 usec,

reliability 255/255, txload 1/255, rxload 1/255
Encapsulation ARPA, loopback not set
Keepalive not set
Full-duplex, 10GB/s, link type is auto, media type is SFP-10Gbase-SR

d) Run the show run interface tengigabitethernet portID command to configure the switch ports where the cables
from the VIC 1227 ports are connected. For example:
MySwitch#show run interface tengigabitethernet 1/1/3
Building configuration...
Current configuration : 129 bytes
!
interface TenGigabitEthernet1/1/3
switchport trunk allowed vlan 99
switchport mode trunk
end

MySwitch#

e) Run the show run interface tengigabitethernet portID command and verify from the command output that
the port has the correct voice vlan dot1p setting. For example:
MySwitch#show run interface tengigabitEthernet 1/1/3
Building configuration...
Current configuration : 129 bytes
!
interface TenGigabitEthernet1/1/3
switchport trunk allowed vlan 99
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switchport mode trunk
switchport voice vlan dot1p
end

MySwitch#

f) Run the show mac address-table interface tengigabitethernet portID command and verify theMAC address
from the command output. For example:
MySwitch#show mac address-table interface tengigabitethernet 1/1/3

Mac Address Table
––––––––––––––––––––––––––––––––––––––––––--
Vlan Mac Address Type Ports
––-- ––––––––––- –––- –––--
99 XXXe.3161.1000 DYNAMIC Te1/1/3
Total Mac Addresses for this criterion: 1

MySwitch#

What to do next

When this task is complete, do one of the following:

• If you need to reinstall Cisco DNA Center software before you configure your appliance, see Reimage
the Appliance.

• If you are ready to configure your appliance, proceed to Appliance Configuration Overview.

Reimage the Appliance
Situations may arise that require you to reimage your Cisco DNA Center appliance, such as recovering from
a backup or changing your cluster link configuration. To do so, complete the following procedure.

Step 1 Download the Cisco DNA Center ISO image and verify that it is a genuine Cisco image.

See Verify the Cisco DNA Center Image, on page 57.

Step 2 Create a bootable USB drive that contains the Cisco DNA Center ISO image.

See Create a Bootable USB Flash Drive, on page 58.

Step 3 Reinitialize the three virtual drives that are managed by your appliance’s RAID controller:
a) Log in to Cisco IMC and start a KVM session.
b) Power on or power cycle the appliance by choosing one of the following menu options:

• Power > Power On System

• Power > Power Cycle System (cold boot)

As your appliance reboots, a screen that lists every drive on the appliance (both physical and virtual) is displayed.

Cisco DNA Center First-Generation Appliance Installation Guide, Release 2.3.7
55

Prepare the Appliance for Configuration
Reimage the Appliance



c) As soon as you see this screen, press Ctrl + R to run the MegaRAID Configuration Utility.

If you wait too long, this screen disappears. To get back to this screen, choose Power > Reset System (warm boot)
from the KVM menu to reboot your appliance.

d) Select a drive’s entry (ID: 0, 446.102 GB, for example) and then press F2.

This opens the drive’s Advanced Properties screen.

e) In the resulting menu, choose Initialization > Full Initialization for the first virtual drive.
f) Repeat Steps 3b through 3e for the other virtual drives on your appliance, but choose Fast Initialize. (Only the first

virtual drive requires full initialization. The second and third virtual drives don’t require full initialization.)

Step 4 Reinstall Cisco DNA Center onto your appliance.

See Install the Cisco DNA Center ISO Image, on page 60.
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Verify the Cisco DNA Center Image
Before deploying Cisco DNACenter, we strongly recommend that you verify that the image you downloaded
is a genuine Cisco image.

Before you begin

Obtain the location of the Cisco DNA Center image (through email or by contacting the Cisco support team).

Step 1 Download the Cisco DNA Center image (.iso, .bin, .zip) from the location specified by Cisco.
Step 2 Download the Cisco public key (cisco_image_verification_key.pub) for signature verification from the location specified

by Cisco.
Step 3 Download the secure hash algorithm (SHA512) checksum file for the image from the location specified by Cisco.
Step 4 Obtain the image's signature file (.sig) from Cisco support through email or by download from the secure Cisco website

(if available).
Step 5 (Optional) Perform an SHA verification to determine whether the image is corrupted due to a partial download.

Depending on your operating system, enter one of the following commands:

• On a Linux system: sha512sum image-filename

• On a Mac system: shasum -a 512 image-filename

Microsoft Windows does not include a built-in checksum utility, but you can use the certutil tool:
certutil -hashfile <filename> sha256 | md5

For example:
certutil -hashfile D:\Customers\FINALIZE.BIN sha256

On Windows, you can also use the Windows PowerShell to generate the digest. For example:
PS C:\Users\Administrator> Get-FileHash -Path D:\Customers\FINALIZE.BIN
Algorithm Hash Path
SHA256 B84B6FFD898A370A605476AC7EC94429B445312A5EEDB96166370E99F2838CB5 D:\Customers\FINALIZE.BIN

Compare the command output to the SHA512 checksum file that you downloaded. If the command output does not match,
download the image again and run the appropriate command a second time. If the output still does not match, contact
Cisco support.

Step 6 Verify that the image is genuine and from Cisco by verifying its signature:

openssl dgst -sha512 -verify cisco_image_verification_key.pub -signature signature-filename image-filename

This command works in both Mac and Linux environments. For Windows, you must download and install
OpenSSL (available here) if you have not already done so.

Note

If the image is genuine, running this command displays a Verified OK message. If this message fails to appear, do not
install the image and contact Cisco support.

Step 7 After confirming that you have downloaded a Cisco image, create a bootable USB drive that contains the Cisco DNA
Center image. See Create a Bootable USB Flash Drive.
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Create a Bootable USB Flash Drive
Complete one of the following procedures to create a bootable USB flash drive from which you can install
the Cisco DNA Center ISO image.

Before you begin:

• Download and verify your copy of the Cisco DNA Center ISO image. See Verify the Cisco DNA Center
Image.

• Confirm that the USB flash drive you are using:

• Is USB 3.0 or later.

• Has a capacity of at least 64 GB.

• Is unencrypted.

Do not use the Rufus utility to burn the Cisco DNA Center ISO image. Use only Etcher, the Linux CLI, or
the Mac CLI.

Note

Using Etcher

Step 1 Download and install Etcher (Version 1.3.1 or later), an open-source freeware utility that allows you to create a bootable
USB drive on your laptop or desktop.

Linux, macOS, and Windows versions of Etcher are currently available. You can download a copy at
https://www.balena.io/etcher/.

Use only theWindows version of Etcher on machines runningWindows 10, as there are known compatibility
issues with older versions of Windows.

Note

Step 2 From the machine on which you installed Etcher, connect a USB drive and then start Etcher.
Step 3 In the top-right corner of the window, click and verify that the following Etcher settings are set:

• Auto-unmount on success

• Validate write on success

Step 4 Click Back to return to the main Etcher window.
Step 5 Click Select Image.
Step 6 Navigate to the Cisco DNA Center ISO image you downloaded previously, select it, and then click Open.

The name of the USB drive you connected should be listed under the drive icon ( ). If it is not:

a. Click Select drive.

b. Click the radio button for the correct USB drive, and then click Continue.

Step 7 Click Flash! to copy the ISO image to the USB drive.
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Etcher configures the USB drive as a bootable drive with the Cisco DNA Center ISO image installed.

Using the Linux CLI

Step 1 Verify that your USB flash drive is recognized by your machine:
a) Insert a flash drive into your machine's USB port.
b) Open a Linux shell and run the following command: lsblk

The command lists the disk partitions that are currently configured on your machine, as illustrated in the following
example:
$ lsblk
NAME MAJ:MIN RM SIZE RO TYPE MOUNTPOINT
sda 8:0 0 446.1G 0 disk
├─sda1 8:1 0 1M 0 part
├─sda2 8:2 0 28.6G 0 part /
├─sda3 8:3 0 28.6G 0 part /install2
├─sda4 8:4 0 9.5G 0 part /var
├─sda5 8:5 0 30.5G 0 part [SWAP]
└─sda6 8:6 0 348.8G 0 part /data
sdb 8:16 0 1.8T 0 disk
├─sdb1 8:17 0 426.1G 0 part /data/maglev/srv/fusion
└─sdb2 8:18 0 1.3T 0 part /data/maglev/srv/maglev-system
sdc 8:32 0 3.5T 0 disk
└─sdc1 8:33 0 3.5T 0 part /data/maglev/srv/ndp
sdd 8:48 1 28.7G 0 disk
└─sdd1 8:49 1 12G 0 part

c) Confirm that an sdd partition (which indicates the presence of a USB flash drive) is listed.

Step 2 Burn the Cisco DNA Center ISO image you downloaded previously onto your USB flash drive: time sudo dd
if=/data/tmp/ISO-image-filename of=/dev/flash-drive-partition bs=4M && sync status=progress

For example, to create a bootable USB drive using an ISO image named CDNAC-SW-1.330.iso, you would run the
following command: time sudo dd if=/data/tmp/CDNAC-SW-1.330.iso of=/dev/sdd bs=4M && sync status=progress

Using the Mac CLI

Step 1 Determine the disk partition associated with your USB flash drive:
a) Open a Terminal window and run the following command: diskutil list

The command lists the disk partitions that are currently configured on your machine.

b) Insert a flash drive into your machine's USB port and run the diskutil list command a second time.

The partition that was not listed the first time you ran this command corresponds to your flash drive. For example,
let's assume that your flash drive's partition is /dev/disk2.

Step 2 Unmount the flash drive's partition: diskutil unmountDisk flash-drive-partition

Continuing our example, you would enter diskutil unmountDisk /dev/disk2
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Step 3 Using the Cisco DNA Center ISO image you downloaded previously, create a disk image: hdiutil convert -format
UDRW -o Cisco-DNA-Center-version ISO-image-filename

Continuing our example, let's assume that you are working with a Cisco DNA Center ISO image named
CDNAC-SW-1.330.iso. Youwould run the following command, which creates amacOS disk image named CDNAC-1.330.dmg:
hdiutil convert -format UDRW -o CDNAC-1.330 CDNAC-SW-1.330.iso

Ensure that the ISO image does not reside on a Box partition.Important

Step 4 Create a bootable USB drive: sudo dd if=macOS-disk-image-filename of=flash-drive-partition bs=1m status=progress

Continuing our example, you would run the following command: sudo dd if=CDNAC-1.330.dmg of=/dev/disk2 bs=1m
status=progress

The ISO image is about 18 GB in size, so this can take around an hour to complete.

Install the Cisco DNA Center ISO Image
Complete the following procedure to install the Cisco DNA Center ISO image onto your appliance.

Before you begin

Create the bootable USB drive from which you will install the Cisco DNA Center ISO image. See Create a
Bootable USB Flash Drive.

Step 1 Connect the bootable USB drive with the Cisco DNA Center ISO image to the appliance.
Step 2 Log in to Cisco IMC and start a KVM session.
Step 3 Power on or power cycle the appliance:

• Choose Power > Power On System if the appliance is not currently running.

• Choose Power > Power Cycle System (cold boot) if the appliance is already running.

Step 4 In the resulting pop-up window, click Yes to acknowledge that you are about to execute a server control action.
Step 5 When the Cisco logo appears, either press the F6 key or choose Macros > User Defined Macros > F6 from the KVM

menu.

The boot device selection menu appears.

Step 6 Select your USB drive and then press Enter.
Step 7 In the GNU GRUB bootloader window, choose Cisco DNA Center Installer and then press Enter.

The bootloader automatically boots the Cisco DNA Center Installer instead if you do not make a selection
within 30 seconds.

Note

The installer reboots and opens the wizard's welcome screen. Depending on whether you are going to configure a primary
or secondary cluster node, proceed to Step 4 in either Configure the Primary Node or Configure a Secondary Node.
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C H A P T E R 5
Configure the Appliance

• Appliance Configuration Overview, on page 61
• Configure the Primary Node, on page 61
• Configure a Secondary Node, on page 75
• Upgrade to the Latest Cisco DNA Center Release, on page 88

Appliance Configuration Overview
You can deploy the appliance in your network in one of the following two modes:

• Standalone: As a single node offering all the functions. This option is usually preferred for initial or test
deployments and in smaller network environments.

• Cluster: As a node that belongs to a three-node cluster. In this mode, all the services and data are shared
among the hosts. This is the preferred option for large deployments.

If you choose the Standalone mode for your initial deployment, you can add more appliances later to form a
cluster. When configuring the standalone host, ensure that it is set it up as the first, or primary, node in the
cluster.

If you choose the Cluster mode for your initial deployment, be sure to finish configuring the primary node
before configuring the secondary nodes.

To proceed, complete the following tasks:

1. Launch theMaglev Configuration wizard fromCisco IMC and configure the primary node in your cluster.
See Configure the Primary Node.

2. If you have installed three appliances and want to add the second and third nodes to your cluster, see
Configure a Secondary Node.

Configure the Primary Node
Perform the steps in this procedure to configure the first installed appliance as the primary node. You must
always configure the first appliance as the primary node, whether it will operate standalone or as part of a
cluster.
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If you are configuring the installed appliance as an secondary node for an existing cluster that already has a
primary node, follow the steps described in Configure a Secondary Node instead.

Ensure that all of the IP addresses you enter while completing this procedure are valid IPv4 addresses with
valid IPv4 netmasks. Also make sure that the addresses and their corresponding subnets do not overlap. Service
communication issues can result if they do.

Note

Before you configure the appliances in a three-node cluster, ensure that you have logged out of those appliances.
Otherwise, the Quick Start workflow (which you complete to discover your network's devices and enable
telemetry) will not start after you have configured your cluster's appliances and log in to Cisco DNA Center
for the first time.

Important

Before you begin

Ensure that you:

• Collected all of the information specified in Required IP Addresses and Subnets and Required
Configuration Information.

• Installed the first appliance, as described in Appliance Installation Workflow.

• Configured Cisco IMC browser access on the primary node, as described in Enable Browser Access to
Cisco Integrated Management Controller.

• Checked that the primary node appliance's ports, and the switches they use, are properly configured, as
described in Execute Preconfiguration Checks.

• Confirmed that you are using a compatible browser. For a list of compatible browsers, see the Release
Notes document for the version of Cisco DNA Center you are installing.

• Enabled ICMP on the firewall between Cisco DNA Center and both the default gateway and the DNS
server you specify in the following procedure. The Maglev Configuration wizard uses ping to verify the
gateway and DNS server you specify. This ping might get blocked if a firewall is in place and ICMP is
not enabled on that firewall. When this happens, you will not be able to complete the wizard.

Step 1 Point your browser to the Cisco IMC IP address you set during the Cisco IMC GUI configuration you performed, and
log in to the Cisco IMC GUI as the Cisco IMC user (see Enable Browser Access to Cisco Integrated Management
Controller).
After successful login, the appliance displays the Cisco Integrated Management Controller Chassis Summary
window, with a hyperlinked menu at the top of the window, as shown below.
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Step 2 From the hyperlinked menu, choose Launch KVM and then select either Java based KVM or HTML based KVM.
If you select Java-based KVM, you will need to launch the Java startup file from your browser or file manager in
order to view the KVM console in its own window. If you select HMTL-based KVM, it launches the KVM console
in a separate window or tab automatically.

Irrespective of the KVM type you choose, use the KVM console to monitor the progress of the configuration and
respond to the Maglev Configuration wizard prompts.

Step 3 With the KVM displayed, reboot the appliance by making one of the following selections:

• In the main Cisco IMC GUI browser window: Choose Host Power > Power Cycle, and switch to the KVM
console to continue.

• In the KVM console: Choose Power > Power Cycle System (cold boot).

If you are asked to confirm your choice to reboot the appliance, click OK.

After displaying reboot messages, the KVM console displays the Maglev Configuration wizard welcome screen.
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Step 4 Click Start a Cisco DNA Center Cluster to begin configuring the primary node.

The wizard discovers all of the ports on the appliance and presents them to you one by one, in separate screens, in the
following order:

a. 10-Gbps Enterprise port (Port 1, enp9s0, Network Adapter #1)

b. 10-Gbps Cluster port (Port 2, enp10s0, Network Adapter #2)

c. 1-Gbps Cisco DNA Center GUI port (1, enp1s0f0, Network Adapter #3)

d. 1-Gbps Cloud port (2, enp1s0f1, Network Adapter #4)

If the wizard fails to display either or both of the Enterprise and Cluster ports during the course of
configuration, these ports may be non-functional or disabled. These two ports are required for Cisco DNA
Center functionality. If you discover that they are non-functional, choose cancel to exit the configuration
immediately. Be sure you have completed all of the steps provided in Execute Preconfiguration Checks
before resuming configuration or contacting the Cisco Technical Assistance Center (TAC).

Note

Step 5 The wizard discovers the 10-Gbps Enterprise port (Port 1, enp9s0) first, and presents it as NETWORK ADAPTER
#1. As explained in Interface Cable Connections, this port is required to link the appliance to the enterprise network.
Apply the host IP address, netmask, and other values that are appropriate for this purpose, (see Required IP Addresses
and Subnets and Required Configuration Information for the values to enter).
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Enter the configuration values for NETWORK ADAPTER #1, as shown in the table below.

Table 16: Primary Node Entries for Network Adapter #1: 10-Gbps Enterprise Port (enp9s0)

Enter the IP address for the 10-Gbps Enterprise port. This is required.Host IP address

Enter the netmask for the port's IP address. This is required.Netmask

Enter a default gateway IP address to use for the port.

Ensure that you enter a default gateway IP address for at least one
of your appliance's interfaces. Otherwise, you will not be able to
complete the configuration wizard.

Important

Default Gateway IP address

Enter the IP address of the preferred DNS server. If you are entering multiple DNS
servers, separate the IP addresses in the list with spaces.

For each appliance in your cluster, configure a maximum of three
DNS servers. Problems can occur if you configure more than three
DNS servers for an appliance.

Important

DNS Servers

Enter one or more static routes in the following format, separated by spaces:
<network>/<netmask>/<gateway>. This is usually required on the Cisco DNA
Center GUI port only.

Static Routes

Leave this field blank. It is required on the Cluster port only.Cluster Link
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After you provide the necessary information, click next>> to proceed. Correct validation errors, if any, as you did in
previous screens. The wizard validates and applies your network adapter configurations.

Step 6 After successful validation of the Enterprise port values you entered, the wizard presents the 10-Gbps Cluster port (Port
2, enp10s0) as NETWORK ADAPTER #2. As explained in Interface Cable Connections, this port is used to link the
appliance to the cluster, so apply the host IP address, netmask, and other values that are appropriate for this purpose
(see Required IP Addresses and Subnets and Required Configuration Information for the values to enter).

Enter the configuration values for NETWORK ADAPTER #2, as shown in the table below.

Table 17: Primary Node Entries for Network Adapter #2: 10-Gbps Cluster Port (enp10s0)

Enter the IP address for the Cluster port. This is required. Note that you cannot
change the address of the Cluster port later.

Host IP address

Enter the netmask for the port's IP address. This is required.Netmask

Enter a default gateway IP address to use for the port.

Ensure that you enter a default gateway IP address for at least one
of your appliance's interfaces. Otherwise, you will not be able to
complete the configuration wizard.

Important

Default Gateway IP address
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Enter the IP address of the preferred DNS server. If you are entering multiple DNS
servers, separate the IP addresses in the list with spaces.

For each appliance in your cluster, configure a maximum of three
DNS servers. Problems can occur if you configure more than three
DNS servers for an appliance.

Important

DNS Servers

Enter one or more static routes in the following format, separated by spaces:
<network>/<netmask>/<gateway>. This is usually required on the GUI port only.

Static Routes

Check the check box to indicate that this port will be the link to a cluster. This is
required on the Cluster port only.

Cluster Link

After you finish entering the configuration values, click next>> to proceed. The wizard validates the values you entered
and issues an error message if any are incorrect. If you receive an error message, check that the value you entered is
correct, then reenter it. If needed, click <<back to reenter it.

Step 7 After successful validation of the Cluster port values you entered, the wizard presents the 1-Gbps Cisco DNA Center
GUI port (1, enp1s0f0) as NETWORK ADAPTER #3. As explained in Interface Cable Connections, this port is used
to access the Cisco DNA Center GUI from your management network. Apply the host IP address, netmask, and other
values that are appropriate for this purpose (see Required IP Addresses and Subnets and Required Configuration
Information for the values to enter).

Enter the configuration values for NETWORK ADAPTER #3, as shown in the table below.
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Table 18: Primary Node Entries for Network Adapter #3: 1-Gbps GUI Port (enp1s0f0)

Enter the IP address for the 1-Gbps GUI Port. This is required only if you are using
theGUI Port to access the CiscoDNACenter GUI from yourmanagement network;
otherwise, you can leave it blank.

Host IP address

Enter the netmask for the port's IP address. This is required if you enter an IP
address.

Netmask

Enter a default gateway IP address to use for the port.

Ensure that you enter a default gateway IP address for at least one
of your appliance's interfaces. Otherwise, you will not be able to
complete the configuration wizard.

Important

Default Gateway IP address

Enter the IP address of the preferred DNS server. If you are entering multiple DNS
servers, separate the IP addresses in the list with spaces.

Important • For NTP, ensure port 123 (UDP) is open between Cisco DNA
Center and your NTP server.

• For each appliance in your cluster, configure a maximum of
three DNS servers. Problems can occur if you configure more
than three DNS servers for an appliance.

DNS Servers

Enter one or more static routes in the following format, separated by spaces:
<network>/<netmask>/<gateway>.

Static Routes

Leave this field blank. It is required on the Cluster port only.Cluster Link

After you provide the necessary information, click next>> to proceed. Correct any validation errors as you did in
previous screens.

Step 8 After successful validation of the Cisco DNA Center GUI port values you entered, the wizard presents the 1-Gbps
Cloud port (2, enp1s0f1) as NETWORK ADAPTER #4. As explained in Interface Cable Connections, this is an
optional port used to link the appliance to the Internet when you cannot do so through the 10-Gbps Enterprise port (Port
1, enp9s0). Apply the host IP address, netmask, and other values that are appropriate for this purpose (see Required IP
Addresses and Subnets and Required Configuration Information for the values to enter).
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Enter the configuration values for NETWORK ADAPTER #4, as shown in the table below.

Table 19: Primary Node Entries for Network Adapter #4: 1-Gbps Cloud Port (enp1s0f1)

Enter the IP address for the Cloud port. This is required only if you are using the
Cloud port for internet connection; otherwise, you can leave it blank.

Host IP address

Enter the netmask for the port's IP address. This is required if you enter an IP
address.

Netmask

Enter a default gateway IP address to use for the Cloud port.

Ensure that you enter a default gateway IP address for at least one
of your appliance's interfaces. Otherwise, you will not be able to
complete the configuration wizard.

Important

Default Gateway IP address

Enter the IP address of the preferred DNS server. If you are entering multiple DNS
servers, separate the IP addresses in the list with spaces.

For each appliance in your cluster, configure a maximum of three
DNS servers. Problems can occur if you configure more than three
DNS servers for an appliance.

Important

DNS Servers

Enter one or more static routes in the following format, separated by spaces:
<network>/<netmask>/<gateway>. This is usually required on the Cisco DNA
Center GUI port only.

Static Routes
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Leave this field blank. It is required on the Cluster port only.Cluster Link

After you provide the necessary information, click next>> to proceed. Correct any validation errors as you did in
previous screens.

Step 9 After the network adapter configuration is complete, the wizard prompts you to enter configuration values for the
NETWORK PROXY you are using, as shown below.

Enter the configuration values for the NETWORK PROXY, as shown in the table below.

Table 20: Primary Node Entries for Network Proxy

Enter the URL or host name of an HTTPS network proxy used to access the
Internet.

Connection fromCiscoDNACenter to the HTTPS proxy is supported
only via HTTP in this release.

Note

HTTPS Proxy

Enter the user name used to access the network proxy. If no proxy login is required,
leave this field blank.

HTTPS Proxy Username

Enter the password used to access the network proxy. If no proxy login is required,
leave this field blank.

HTTPS Proxy Password

After you provide the necessary information, click next>> to proceed. Correct validation errors, if any, as you did in
previous screens.

Step 10 After network proxy configuration completes, the wizard prompts you to enter virtual IP addresses for the primary
node, in MAGLEV CLUSTER DETAILS, as shown below.
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Enter a space-separated list of the virtual IP addresses used for traffic between the cluster and your network. This is
required for both three-node clusters and single-node clusters that will be converted into a three-node cluster in the
future. If you have a single-node cluster setup and plan to stick with it, skip this step and proceed to Step 11.

You must enter one virtual IP address for each configured network interface. You will not be able to
complete the wizard unless you do so. These addresses are tied to the cluster link's status, which must be
in the UP state.

Important

You also have the option to specify the fully qualified domain name (FQDN) for your cluster. Cisco DNA Center uses
this domain name to do the following:

• It uses this hostname to access your cluster’s web interface and the Representational State Transfer (REST) APIs
used by devices in the enterprise network that Cisco DNA Center manages.

• In the Subject Alternative Name (SAN) field of Cisco DNA Center certificates, it uses the FQDN to the define
the Plug and Play server that should be used for device provisioning.

After you provide the necessary information, click next>> to proceed. Correct validation errors, if any, as you did in
previous screens.

Step 11 After you have entered the virtual IP addresses, the wizard prompts you to enter USER ACCOUNT SETTINGS
values, as shown below.
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Enter the values for USER ACCOUNT SETTINGS, as shown in the table below.

Table 21: Primary Node Entries for User Account Settings

Enter a Linux password for the maglev user.Linux Password

Confirm the Linux password by entering it a second time.Re-enter Linux Password

If you do not want to create the Linux password yourself, enter a seed phrase in
this field and then press <Generate Password> to generate the password.

Password Generation Seed

(Optional) The seed phrase appears as part of a random and secure password. If
desired, you can either use this password "as is", or you can further edit this
auto-generated password.

Press <Use Generated Password> to save the password.

Auto Generated Password

Enter a password for the default admin superuser, used to log in to Cisco DNA
Center for the first time.

Administrator Passphrase

Confirm the administrator passphrase by entering it a second time.Re-enter Administrator
Passphrase

After you provide the necessary information, click next>> to proceed. Correct validation errors, if any, as you did in
previous screens.

Step 12 After you have entered the user account details, the wizard prompts you to enter NTP SERVER SETTINGS values,
as shown below.
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Enter one or more NTP server addresses or hostnames, separated by spaces. At least one NTP address or hostname is
required. For a production deployment, we recommend that you configure a minimum of three NTP servers.

After you provide the necessary information, click next>> to proceed. Correct validation errors, if any, as you did in
previous screens. The wizard validates and applies your NTP server configuration.

Step 13 After you have specified the appropriate NTP servers, the wizard prompts you to enter MAGLEV ADVANCED
SETTINGS values, as shown below.
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Enter the configuration values for MAGLEV ADVANCED SETTINGS, as shown in the table below.

Table 22: Primary Node Entries for Maglev Advanced Settings

A dedicated, non-routed IP subnet that Cisco DNACenter uses to manage internal
services. By default, this is already set to 169.254.32.0/20, and we recommend
that you use this subnet. If you choose to enter another subnet, ensure that it does
not conflict with or overlap any other subnet used by the Cisco DNACenter internal
network or an external network. For more information, see the Container Subnet
description in Required IP Addresses and Subnets, on page 17.

Container Subnet

A dedicated, non-routed IP subnet that Cisco DNACenter uses to manage internal
cluster services. By default, this is already set to 169.254.48.0/20, and we
recommend that you use this subnet. If you choose to enter another subnet, ensure
that it does not conflict with or overlap any other subnet used by the Cisco DNA
Center internal network or an external network. For more information, see the
Cluster Subnet description in Required IP Addresses and Subnets, on page 17.

Cluster Subnet

When you are finished, click next>> to proceed. Correct validation errors, if any, as you did in previous screens.

Step 14 After you have entered the Maglev advanced settings, a final message appears, stating that the wizard is ready to apply
the configuration (as shown below).
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Click proceed>> to complete the configuration wizard.

The host will reboot automatically and display messages on the KVM console as it applies your settings and brings up
services. This process can take several hours. You can monitor its progress via the KVM console.

At the end of the configuration process, the appliance power cycles again, then displays a CONFIGURATION
SUCCEEDED! message.

What to do next

• If you are deploying this appliance in standalone mode only, perform the first-time setup: First-Time
Setup Workflow.

• If you are deploying this appliance as the primary node in a cluster, configure the second and third
installed appliances in the cluster: Configure a Secondary Node.

Configure a Secondary Node
Perform the steps in this procedure to configure the second and third appliances in the cluster.

In order to build a three-node cluster, the same version of the System package must be installed on your three
Cisco DNA Center appliances. Otherwise, unexpected behavior and possible downtime can occur.

Important
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Ensure that all of the IP addresses you enter while completing this procedure are valid IPv4 addresses with
valid IPv4 netmasks. Also make sure that the addresses and their corresponding subnets do not overlap. Service
communication issues can result if they do.

Note

Before you configure the appliances in a three-node cluster, ensure that you have logged out of those appliances.
Otherwise, the Quick Start workflow (which you complete to discover your network's devices and enable
telemetry) will not start after you have configured your cluster's appliances and log in to Cisco DNA Center
for the first time.

Important

When joining each new secondary node to the cluster, you must specify the first host in the cluster as the
primary node. Note the following when joining secondary nodes to a cluster:

• Be sure to join only a single node to the cluster at a time. Do not attempt to add multiple nodes at the
same time, because this results in unpredictable behavior.

• Before adding a new node to the cluster, be sure that all installed packages are deployed on the primary
node. You can check this by using Secure Shell to log in to the primary node's Cisco DNA Center
Management port as the Linux user (maglev) and then running the command maglev package status.
All installed packages should appear in the command output as DEPLOYED. In the following example, a
few packages were not installed, such as the application-policy and sd-access packages. They are the
only packages whose status is NOT_DEPLOYED. Your package status should look similar to this before
configuring a secondary node.

• Expect some service downtime during the cluster attachment process for each secondary node. Services
will need to be redistributed across the nodes and the cluster will be down for periods of time during that
process.
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Before you begin

Ensure that you:

• Configured the first appliance in the cluster, following the steps in Configure the Primary Node.

• Collected all of the information specified in Required IP Addresses and Subnets and Required
Configuration Information.

• Installed the second and third appliances, as described in Appliance Installation Workflow.

• Have done the following:

1. Ran the maglev package status command on the first appliance.

You can also access this information from the Cisco DNA Center GUI by clicking the Help icon

( ) and choosing About > Packages.

2. Contacted the Cisco TAC, gave them the output of this command, and asked them to point you to
the ISO that you should install on your second and third appliances.

• Configured Cisco IMC browser access on both secondary appliances, as described in Enable Browser
Access to Cisco Integrated Management Controller.

• Checked that both the secondary node appliances' ports, and the switches they use, are properly configured,
as described in Execute Preconfiguration Checks.

• Confirmed that you are using a compatible browser. For a list of compatible browsers, see the Release
Notes document for the version of Cisco DNA Center you are installing.

• Enabled ICMP on the firewall between Cisco DNA Center and both the default gateway and the DNS
server you specify in the following procedure. The Maglev Configuration wizard uses ping to verify the
gateway and DNS server you specify. This ping might get blocked if a firewall is in place and ICMP is
not enabled on that firewall. When this happens, you will not be able to complete the wizard.

Step 1 Point your browser to the Cisco IMC IP address you set during the Cisco IMC GUI configuration you performed, and
log in to the Cisco IMC GUI as the Cisco IMC user (see Enable Browser Access to Cisco Integrated Management
Controller).
After successful login, the appliance displays the Cisco Integrated Management Controller Chassis Summary
window, with a hyperlinked menu at the top of the window, as shown below.
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Step 2 From the hyperlinked menu, choose Launch KVM and then select either Java based KVM or HTML based KVM.
If you select Java-based KVM, you will need to launch the Java startup file from your browser or file manager in
order to view the KVM console in its own window. If you select HMTL-based KVM, it launches the KVM console
in a separate window or tab automatically.

Irrespective of the KVM type you choose, use the KVM console to monitor the progress of the configuration and
respond to the Maglev Configuration wizard prompts.

Step 3 With the KVM displayed, reboot the appliance by choosing one of the following options:

• In the main Cisco IMC GUI browser window: Choose Host Power > Power Cycle, and switch to the KVM
console to continue.

• In the KVM console: Choose Power > Power Cycle System (cold boot).

If you are asked to confirm your choice to reboot the appliance, click OK.

After displaying reboot messages, the KVM console displays the Maglev Configuration wizard welcome screen.

Step 4 Click Join a Cisco DNA Center Cluster to begin configuring the secondary node.

The wizard discovers all of the ports on the appliance and presents them to you one by one, in separate screens, in the
following order:

a. 10-Gbps Enterprise port (Port 1, enp9s0, Network Adapter #1)

b. 10-Gbps Cluster port (Port 2, enp10s0, Network Adapter #2)

c. 1-Gbps Cisco DNA Center GUI port (1, enp1s0f0, Network Adapter #3)

d. 1-Gbps Cloud port (2, enp1s0f1, Network Adapter #4)
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If the wizard fails to display one or both of the 10-Gbps ports during the course of configuration, it might
indicate that these ports are nonfunctional or disabled. These 10-Gbps ports are required for Cisco DNA
Center functionality. If you discover that they are nonfunctional, choose cancel to exit the configuration
wizard immediately. Be sure that you have completed all of the steps provided in Execute Preconfiguration
Checks before resuming the configuration or by contacting the Cisco Technical Assistance Center (for
more information, see the "Get Assistance from the Cisco TAC" topic in the Release Notes document).

Note

Step 5 The wizard discovers the 10-Gbps Enterprise port (Port 1, enp9s0) first, and presents it as NETWORK ADAPTER
#1. As explained in Interface Cable Connections, this port is required to link the appliance to the enterprise network.
Apply the host IP address, netmask, and other values that are appropriate for this purpose (see Required IP Addresses
and Subnets and Required Configuration Information for the values to enter).

Enter the configuration values for NETWORK ADAPTER #1, as shown in the table below.

Table 23: Secondary Node Entries for Network Adapter #1: 10-Gbps Enterprise Port (enp9s0)

Enter the IP address for the 10-Gbps Enterprise port. This is required.Host IP address

Enter the netmask for the port's IP address. This is required.Netmask

Enter a default gateway IP address to use for the port.

Ensure that you enter a default gateway IP address for at least one
of your appliance's interfaces. Otherwise, you will not be able to
complete the configuration wizard.

Important

Default Gateway IP address

Cisco DNA Center First-Generation Appliance Installation Guide, Release 2.3.7
79

Configure the Appliance
Configure a Secondary Node

https://www.cisco.com/c/en/us/support/cloud-systems-management/dna-center/products-release-notes-list.html


Enter the IP address of the preferred DNS server. If you are entering multiple DNS
servers, separate the IP addresses in the list with spaces.

For each appliance in your cluster, configure a maximum of three
DNS servers. Problems can occur if you configure more than three
DNS servers for an appliance.

Important

DNS Servers

Enter one or more static routes in the following format, separated by spaces:
<network>/<netmask>/<gateway>. This is usually required on the GUI port only.

Static Routes

Leave this field blank. It is required on the Cluster port only.Cluster Link

After you provide the necessary information, click next>> to proceed. Correct validation errors, if any, as you did in
previous screens.

Step 6 After successful validation of the Enterprise port values you entered, the wizard presents the 10-Gbps Cluster port (Port
2, enp10s0) as NETWORK ADAPTER #2. As explained in Interface Cable Connections, this port is used to link the
appliance to the cluster, so apply the host IP address, netmask, and other values that are appropriate for this purpose
(see Required IP Addresses and Subnets and Required Configuration Information for the values to enter).

Enter configuration values for NETWORK ADAPTER #2 as shown in the table below.

Table 24: Secondary Node Entries for Network Adapter #2: 10-Gbps Cluster Port (enp10s0)

Enter the IP address for the Cluster port. This is required. Note that you cannot
change the address of the Cluster port later.

Host IP address
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Enter the netmask for the port's IP address. This is required.Netmask

Enter a default gateway IP address to use for the port.

Ensure that you enter a default gateway IP address for at least one
of your appliance's interfaces. Otherwise, you will not be able to
complete the configuration wizard.

Important

Default Gateway IP address

Enter the IP address of the preferred DNS server. If you are entering multiple DNS
servers, separate the IP addresses in the list with spaces.

For each appliance in your cluster, configure a maximum of three
DNS servers. Problems can occur if you configure more than three
DNS servers for an appliance.

Important

DNS Servers

Enter one or more static routes in the following format, separated by spaces:
<network>/<netmask>/<gateway>. This is usually required on the Cisco DNA
Center GUI port only.

Static Routes

Check the check box to indicate that this port will be the link to a cluster. This is
required on the Cluster port only.

Cluster Link

After you finish entering the configuration values, click next>> to proceed. The wizard validates the values you entered
and issues an error message if any are incorrect. If you receive an error message, check that the value you entered is
correct, then reenter it. If needed, click <<back to reenter it.

Step 7 After successful validation of the Cluster port values you entered, the wizard presents the 1-Gbps Cisco DNA Center
GUI port (1, enp1s0f0) as NETWORK ADAPTER #3. As explained in Interface Cable Connections, this port is used
to access the Cisco DNA Center GUI from your management network. Apply the host IP address, netmask, and other
values that are appropriate for this purpose (see Required IP Addresses and Subnets and Required Configuration
Information for the values to enter).
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Enter the configuration values for NETWORK ADAPTER #3, as shown in the table below.

Table 25: Secondary Node Entries for Network Adapter #3: 1-Gbps GUI Port (enp1s0f0)

Enter the IP address for the 1-Gbps GUI Port. This is required only if you are using
theGUI Port to access the CiscoDNACenter GUI from yourmanagement network;
otherwise, you can leave it blank.

Host IP address

Enter the netmask for the port's IP address. This is required if you enter an IP
address.

Netmask

Enter a default gateway IP address to use for the port.

Ensure that you enter a default gateway IP address for at least one
of your appliance's interfaces. Otherwise, you will not be able to
complete the configuration wizard.

Important

Default Gateway IP address

Enter the IP address of the preferred DNS server. If you are entering multiple DNS
servers, separate the IP addresses in the list with spaces.

Important • For NTP, ensure port 123 (UDP) is open between Cisco DNA
Center and your NTP server.

• For each appliance in your cluster, configure a maximum of
three DNS servers. Problems can occur if you configure more
than three DNS servers for an appliance.

DNS Servers
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Enter one or more static routes in the following format, separated by spaces:
<network>/<netmask>/<gateway>.

Static Routes

Leave this field blank. It is required on the Cluster port only.Cluster Link

After you provide the necessary information, click next>> to proceed. Correct validation errors, if any, as you did in
previous screens.

Step 8 After successful validation of the Cisco DNA Center GUI port values you entered, the wizard presents the 1-Gbps
Cloud port (2, enp1s0f1) as NETWORK ADAPTER #4. As explained in Interface Cable Connections, this is an
optional port used to link the appliance to the Internet when you cannot do so through the 10-Gbps Enterprise port (Port
1, enp9s0). Apply the host IP address, netmask, and other values that are appropriate for this purpose (see Required IP
Addresses and Subnets and Required Configuration Information for the values to enter).

Enter the configuration values for NETWORK ADAPTER #4, as shown in the table below.

Table 26: Secondary Node Entries for Network Adapter #4: 1-Gbps Cloud Port (enp1s0f1)

Enter the IP address for the Cloud port. This is required only if you are using the
Cloud port for internet connection; otherwise, you can leave it blank.

Host IP address

Enter the netmask for the port's IP address. This is required if you enter an IP
address.

Netmask
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Enter a default gateway IP address to use for the Cloud port.

Ensure that you enter a default gateway IP address for at least one
of your appliance's interfaces. Otherwise, you will not be able to
complete the configuration wizard.

Important

Default Gateway IP address

Enter the IP address of the preferred DNS server. If you are entering multiple DNS
servers, separate the IP addresses in the list with spaces.

For each appliance in your cluster, configure a maximum of three
DNS servers. Problems can occur if you configure more than three
DNS servers for an appliance.

Important

DNS Servers

Enter one or more static routes in the following format, separated by spaces:
<network>/<netmask>/<gateway>. This is usually required on the GUI port only.

Static Routes

Leave this field blank. It is required on the Cluster port only.Cluster Link

After you provide the necessary information, click next>> to proceed. Correct validation errors, if any, as you did in
previous screens.

Step 9 After the network adapter configuration is complete, the wizard prompts you to enter configuration values for the
NETWORK PROXY that you are using, as shown below.

Enter the configuration values for the NETWORK PROXY, as shown in the table below.
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Table 27: Secondary Node Entries for Network Proxy

Enter the URL or host name of an HTTPS network proxy used to access the
Internet.

Connection fromCiscoDNACenter to the HTTPS proxy is supported
only through HTTP in this release.

Note

HTTPS Proxy

Enter the user name used to access the network proxy. If no proxy login is required,
leave this field blank.

HTTPS Proxy Username

Enter the password used to access the network proxy. If no proxy login is required,
leave this field blank.

HTTPS Proxy Password

After you provide the necessary information, click next>> to proceed. Correct validation errors, if any, as you did in
previous screens.

Step 10 After network proxy configuration completes, the wizard prompts you to identify the Cluster port on the primary node,
and primary node login details, in MAGLEV CLUSTER DETAILS, as shown below.

Enter the values for MAGLEV CLUSTER DETAILS, as shown in the table below.

Table 28: Secondary Node Entries for Maglev Cluster Details

Enter the IP address of the Cluster port on the primary node in the cluster. If you
have followed the recommendations for port assignment, this will be the IP address
of Port 2, enp10s0, Network Adapter #1 on the primary node.

Maglev Primary Node

Enter maglev.Username

Enter the Linux password you configured on the primary node.Password
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After you provide the necessary information, click next>> to proceed. Correct validation errors, if any, as you did in
previous screens.

Step 11 After you have entered the Maglev cluster details, the wizard prompts you to enter USER ACCOUNT SETTINGS
values for this secondary node, as shown below.

Enter the values for USER ACCOUNT SETTINGS, as shown in the table below.

Table 29: Secondary Node Entries for User Account Settings

Enter a Linux password for the maglev user.Linux Password

Confirm the Linux password by entering it a second time.Re-enter Linux Password

If you do not want to create the Linux password yourself, enter a seed phrase in
this field and then press <Generate Password> to generate the password.

Password Generation Seed

(Optional) The seed phrase appears as part of a random and secure password. If
required, you can either use this password as is, or you can further edit this
auto-generated password.

Click <Use Generated Password> to save the password.

Auto Generated Password

Enter a password for the default admin superuser, used to log in to Cisco DNA
Center for the first time.

Administrator Passphrase

Confirm the administrator passphrase by entering it a second time.Re-enter Administrator
Passphrase

After you provide the necessary information, click next>> to proceed. Correct validation errors, if any, as you did in
previous screens.
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Step 12 After you have entered the user account details, the wizard prompts you to enter NTP SERVER SETTINGS values,
as shown below.

Enter one or more NTP server addresses or hostnames, separated by spaces. At least one NTP address or hostname is
required. They should be the same NTP servers you specified for the primary node.

After you provide the necessary information, click next>> to proceed. Correct validation errors, if any, as you did in
previous screens.

Step 13 When you are finished entering the NTP server settings, a final message appears, stating that the wizard is ready to
apply the configuration (as shown below).
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Click proceed>> to complete the configuration wizard.

The host will reboot automatically and display messages on the KVM console as it applies your settings and brings up
services. This process can take several hours. You can monitor its progress via the KVM console.

At the end of the configuration process, the appliance power cycles again, then displays a CONFIGURATION
SUCCEEDED! message.

What to do next

• If you have an additional appliance to deploy as the third and final node in the cluster, repeat this procedure.

• If you have finished adding hosts to the cluster, perform the first-time setup: First-Time SetupWorkflow.

Upgrade to the Latest Cisco DNA Center Release
For information about upgrading your current release of Cisco DNA Center, see the Cisco DNA Center
Upgrade Guide.
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C H A P T E R 6
Complete First-Time Setup

• First-Time Setup Workflow, on page 89
• Compatible Browsers, on page 89
• Complete the Quick Start Workflow, on page 89
• Integrate Cisco ISE with Cisco DNA Center, on page 94
• Configure Authentication and Policy Servers, on page 100
• Configure SNMP Properties, on page 103

First-Time Setup Workflow
After you finish configuring all of the Cisco DNA Center appliances you have installed, perform the tasks
described in this chapter to prepare Cisco DNA Center for production use. Note the following points:

• For the parameter information you need to complete this work, see Required First-Time Setup Information.

• If you plan to deploy high availability (HA) in your production environment, you will need to redistribute
services among your cluster nodes to optimize HA operation (see Activate HA, on page 113). Complete
this step after you have configured the SNMP settings for your appliances.

Compatible Browsers
The Cisco DNA Center GUI is compatible with the following HTTPS-enabled browsers:

• Google Chrome: Version 93 or later.

• Mozilla Firefox: Version 92 or later.

We recommend that the client systems you use to log in to Cisco DNACenter be equipped with 64-bit operating
systems and browsers.

Complete the Quick Start Workflow
After you have installed and configured the Cisco DNA Center appliance, you can log in to its GUI. Use a
compatible, HTTPS-enabled browser when accessing Cisco DNA Center.
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When you log in for the first time as the admin superuser (with the username admin and the
SUPER-ADMIN-ROLE assigned), the Quick Start workflow automatically starts. Complete this workflow
to discover the devices that Cisco DNA Center will manage and enable the collection of telemetry from those
devices.

Before you begin

To log in to Cisco DNA Center and complete the Quick Start workflow, you will need:

• The admin superuser username and password that you specified while completing the procedure described
in Configure the Primary Node, on page 61.

• The information described in Required First-Time Setup Information, on page 33.

Step 1 After the Cisco DNA Center appliance reboot is completed, launch your browser.
Step 2 Enter the host IP address to access the Cisco DNA Center GUI, using HTTPS:// and the IP address of the Cisco DNA

Center GUI that was displayed at the end of the configuration process.

After entering the IP address, one of the following messages appears (depending on the browser you are using):

• Google Chrome: Your connection is not private

• Mozilla Firefox: Warning: Potential Security Risk Ahead

Step 3 Ignore the message and click Advanced.

One of the following messages appears:

• Google Chrome:
This server could not prove that it is GUI-IP-address; its security certificate is not trusted
by your computer's
operating system. This may be caused by a misconfiguration or an attacker intercepting your
connection.

• Mozilla Firefox:
Someone could be trying to impersonate the site and you should not continue.

Websites prove their identity via certificates. Firefox does not trust GUI-IP-address because
its certificate issuer is unknown,
the certificate is self-signed, or the server is not sending the correct intermediate certificates.

These messages appear because the controller uses a self-signed certificate. For information on how Cisco DNA Center
uses certificates, see the "Certificate and Private Key Support" section in the Cisco DNA Center Administrator Guide.

Step 4 Ignore the message and do one of the following:

• Google Chrome: Click the Proceed to GUI-IP-address (unsafe) link.

• Mozilla Firefox: Click Accept the Risk and Continue.

The Cisco DNA Center login screen appears.

Step 5 Enter the admin's username (admin) and password that you set when you configured your Cisco DNA Center appliance,
then click Log In.

In the next screen, you are prompted to specify a new admin password (as a security measure).
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Step 6 Do one of the following:

• If you don't want to change the admin password at this time, click Skip.

• To set a new admin password:

a. Enter the same password that you specified in Step 5.

b. Enter and confirm a new admin password.

c. Click Next.

Step 7 Enter your cisco.com username and password (which are used to register software downloads and receive system
communications) and then click Next.

If you don't want to enter these credentials at this time, click Skip instead.Note

The Terms & Conditions screen opens, providing links to the software End User License Agreement (EULA) and any
supplemental terms that are currently available.

Step 8 After reviewing these documents, click Next to accept the EULA.

The Quick Start Overview slider opens. Click > to view a description of the tasks that the Quick Start workflow will
help you complete in order to start using Cisco DNA Center.

Step 9 Complete the Quick Start workflow:
a) Click Let's Do it.
b) In the Discover Devices: Provide IP Ranges screen, enter the following information and then click Next:

• The name for the device discovery job.

• The IP address ranges of the devices you want to discover. Click + to enter additional ranges.

• Specify whether you want to designate your appliance's loopback address as its preferred management IP address.
For more information, see the "Preferred Management IP Address" topic in the Cisco DNA Center User Guide.

c) In the Discover Devices: Provide Credentials screen, enter the information described in the following table for the
type of credentials you want to configure and then click Next:

DescriptionField

CLI (SSH) Credentials

Username used to log in to the CLI of the devices in your network.Username

Password used to log in to the CLI of the devices in your network.Password

Name or description of the CLI credentials.Name/Description

Password used to enable a higher privilege level in the CLI. Configure this
password only if your network devices require it.

Enable Password

SNMP Credentials: SNMPv2c Read tab

Name or description of the SNMPv2c read community string.Name/Description
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DescriptionField

Read-only community string password used only to view SNMP information on
the device.

Community String

SNMP Credentials: SNMPv2c Write tab

Name or description of the SNMPv2c write community string.Name/Description

Write community string used to make changes to the SNMP information on the
device.

Community String

SNMP Credentials: SNMPv3

Name or description of the SNMPv3 credentials.Name/Description

Username associated with the SNMPv3 credentials.Username

Security level that SNMP messages require:

• No Authentication, No Privacy (noAuthnoPriv): Does not provide
authentication or encryption.

• Authentication, No Privacy (authNoPriv): Provides authentication, but
does not provide encryption.

• Authentication and Privacy (authPriv): Provides both authentication and
encryption.

Mode

Password required to gain access to information from devices that use SNMPv3.
The password must be at least eight characters in length. Note the following
points:

• Some wireless controllers require that passwords be at least 12 characters
long. Be sure to check theminimum password requirements for your wireless
controllers. Failure to ensure these required minimum character lengths for
passwords results in devices not being discovered, monitored, or managed
by Cisco DNA Center.

• Passwords are encrypted for security reasons and are not displayed in the
configuration.

Authentication Password

Hash-based Message Authentication Code (HMAC) type used when either
Authentication and Privacy or Authentication, No Privacy is set as the
authentication mode:

• SHA: HMAC-SHA authentication.

• MD5: HMAC-MD5 authentication.

Authentication Type
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DescriptionField

Privacy type used when Authentication and Privacy is set as the authentication
mode. Choose one of the following privacy types:

• AES128: 128-bit CBC mode AES for encryption.

• AES192: 192-bit CBC mode AES for encryption.

• AES256: 256-bit CBC mode AES for encryption.

Note • Discovery and Inventory features support only AES192 and
AES256 privacy types.

• Cisco DNA Assurance does not support any of these privacy
types.

Privacy Type

SNMPv3 privacy password that is used to generate the secret key for encrypting
messages are exchanged with devices supported with AES128, AES192, and
AES256 encryption standards. Passwords (or passphrases) must be at least eight
characters long.

Note the following points:

• Some wireless controllers require that passwords be at least 12 characters
long. Be sure to check theminimum password requirements for your wireless
controllers. Failure to ensure these required minimum character lengths for
passwords results in devices not being discovered, monitored, or managed
by Cisco DNA Center.

• Passwords are encrypted for security reasons and are not displayed in the
configuration.

Privacy Password

NETCONF

The NETCONF port that Cisco DNA Center should use in order to discover
wireless controllers that run Cisco IOS-XE.

Port

d) In the Create Site screen, group the devices you are going to discover into one site in order to facilitate telemetry
and then click Next.

You can enter the site's information manually or click the location you want to use in the provided map.

e) In theEnable Telemetry screen, check the network components that you want Cisco DNACenter to collect telemetry
for and then click Next.

If both the Enable Telemetry and Disable Telemetry options are grayed out, this indicates that either
devices are not capable of supporting telemetry or devices are running an OS version that does not support
telemetry enablement.

Note

f) In the Summary screen, review the settings that you have entered and then do one of the following:

• If you want to make changes, click the appropriate Edit link to open the relevant screen.

• If you're happy with the settings, click Start Discovery and Telemetry. Cisco DNA Center validates your
settings to ensure that they will not result in any issues. After validation is complete, the screen updates.
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Cisco DNA Center begins the process of discovering your network's devices and enabling telemetry for the
network components you selected. The process will take a minimum of 30 minutes (more for larger networks).

A message appears at the top of the homepage to indicate when the Quick Start workflow has completed.

g) Do one of the following:

• Click View Discovery to open the Discovery page and confirm that the devices in your network have been
discovered.

• Click the Go to Network Settings link to open the Device Credentials page. From here, you can verify that
the credentials you entered previously have been configured for your site.

• Click the View Activity Page link to open the Tasks page and view any tasks (such as a weekly scan of the
network for security advisories) that Cisco DNA Center has already scheduled to run.

• Click theWorkflow Home link to access guided workflows that will help you set up and maintain your network.

Integrate Cisco ISE with Cisco DNA Center
Cisco DNACenter provides a mechanism to create a trusted communications link with Cisco ISE and to share
data with Cisco ISE in a secure manner. After Cisco ISE is registered with Cisco DNA Center, any device
that Cisco DNA Center discovers, along with relevant configuration and other data, is pushed to Cisco ISE.
You can use Cisco DNA Center to discover devices and then apply both Cisco DNA Center and Cisco ISE
functions to them because these devices will be displayed in both the applications. Cisco DNA Center and
Cisco ISE devices are all uniquely identified by their device names.

As soon as the devices are provisioned and assigned to a particular site in the Cisco DNACenter site hierarchy,
Cisco DNA Center devices are pushed to Cisco ISE. Any updates to a Cisco DNA Center device (such as
changes to IP address, SNMP or CLI credentials, Cisco ISE shared secret, and so on) will be sent to the
corresponding device instance on ISE automatically. Note that Cisco DNACenter devices are pushed to Cisco
ISE only when these devices are associated with a particular site where Cisco ISE is configured as its AAA
server.

Before you begin

Before attempting to integrate Cisco ISE with Cisco DNA Center, ensure that you have met the following
prerequisites:

• You have deployed one or more Cisco ISE hosts on your network. For information on supported Cisco
ISE versions, see the Cisco DNA Center Compatibility Matrix. For information on installing Cisco ISE,
see the Cisco Identity Services Engine Install and Upgrade guides.

• If you have a standalone Cisco ISE deployment, you must integrate Cisco DNA Center with the Cisco
ISE node and enable the pxGrid service and External RESTful Services (ERS) on that node.

Although pxGrid 2.0 allows up to four pxGrid nodes in the Cisco ISE deployment,
Cisco DNA Center releases earlier than 2.2.1.x do not support more than two
pxGrid nodes.

Note

Cisco DNA Center First-Generation Appliance Installation Guide, Release 2.3.7
94

Complete First-Time Setup
Integrate Cisco ISE with Cisco DNA Center

https://www.cisco.com/c/en/us/support/cloud-systems-management/dna-center/products-device-support-tables-list.html
https://www.cisco.com/c/en/us/support/security/identity-services-engine/products-installation-guides-list.html


• If you have a distributed Cisco ISE deployment:

• You must integrate Cisco DNA Center with the primary policy administration node (PAN), and
enable ERS on the PAN.

We recommend that you use ERS through the PAN. However, for backup, you
can enable ERS on the PSNs.

Note

• Youmust enable the pxGrid service on one of the Cisco ISE nodes within the distributed deployment.
Although you can choose to do so, you do not have to enable pxGrid on the PAN. You can enable
pxGrid on any Cisco ISE node in your distributed deployment.

• The PSNs that you configure in Cisco ISE to handle TrustSec or SD Access content and PACs must
also be defined in Work Centers > Trustsec > Trustsec Servers > Trustsec AAA Servers. For
more information, see the Cisco Identity Services Engine Administrator Guide.

• Only a user with Super Admin role permissions can integrate Cisco ISE with Cisco DNA Center.

• Cisco DNA Center does not support ERS API access if the Use CSRF Check for Enhanced Security
option is enabled in Cisco ISE.

• You must enable communication between Cisco DNACenter and Cisco ISE on the following ports: 443,
5222, 8910, and 9060.

• The Cisco ISE host on which pxGrid is enabled must be reachable from Cisco DNA Center on the IP
address of the Cisco ISE eth0 interface.

• The Cisco ISE node can reach the fabric underlay network via the appliance's NIC.

• Cisco DNACenter will check the certificate revocation status if Online Certificate Status Protocol (OCSP)
or certificate revocation list (CRL) validation is defined for the certificates used by the Cisco ISE services.

• The Cisco ISE admin node certificate must contain the Cisco ISE IP address or FQDN in either the
certificate subject name or the Subject Alternative Name (SAN).

• Your ability to use an FQDN-only system certificate depends on whether LAN automation is enabled in
your Cisco DNA Center deployment. For more information, see the alt_names section bullet in Step 3
of the Cisco DNA Center Security Best Practices Guide's "Generate a Certificate Request Using Open
SSL" topic.

For Cisco ISE 2.4 Patch 13, 2.6 Patch 7, and 2.7 Patch 3, if you are using the
Cisco ISE default self-signed certificate as the pxGrid certificate, Cisco ISEmight
reject that certificate after applying those patches. This is because the older
versions of that certificate have the Netscape Cert Type extension specified as
the SSL server, which now fails (because a client certificate is required).

This issue does not occur in Cisco ISE 3.0 and later. For more information, see
the Cisco ISE Release Notes.

Note
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For more information about configuring Cisco ISE for Cisco DNA Center, see the "Integration with Cisco
DNA Center" topic in the Cisco Identity Services Engine Administrator Guide.

Step 1 Enable the pxGrid service and ERS on Cisco ISE:
a) Log in to the primary policy administration node.
b) In the Cisco ISE GUI, click the menu icon and choose Administration > System > Deployment.

The Deployment Nodes window appears.

c) Click the hostname of the Cisco ISE node on which you want to enable the pxGrid service. In a distributed deployment,
this can be any Cisco ISE node in the deployment.

The Edit Node window appears.

d) In the General Settings tab, check the pxGrid check box, and click Save.
e) In the Cisco ISE GUI, click the menu icon and choose Administration > System > Settings.
f) From the left navigation pane, click ERS Settings to open the ERS Settings window.
g) Click the Enable ERS for Read/Write radio button, and then click OK in the notification prompt.
h) Click Save.

Step 2 Add the Cisco ISE node to Cisco DNA Center as a AAA server:
a) Log in to the Cisco DNA Center GUI.
b) From the top-left corner, click the menu icon and choose System > System 360.
c) In the Identity Services Engine (ISE) pane, click the Configure link.
d) From the Authentication and Policy Servers window, click Add and choose ISE from the drop-down list.
e) Enter the following details in the Add ISE server slide-in pane:

• In the Server IP Address field, enter the IP address of the Cisco ISE server.

• Enter the Shared Secret used to secure communications between your network devices and Cisco ISE.

• In the Username and Password fields, enter the corresponding Cisco ISE admin credentials.

• Enter the FQDN for the Cisco ISE node.

• (Optional) Enter the virtual IP address of the load balancer behind which the Cisco ISE PSNs are located. If
you have multiple policy service node farms behind different load balancers, you can enter a maximum of six
virtual IP addresses.

• Connect to pxGrid: Check this check box under Advanced Settings to enable pxGrid connection.

If you want to use the Cisco DNA Center system certificate as the pxGrid client certificate (sent to ISE to
authenticate the Cisco DNA Center system as a pxGrid client), check the Use Cisco DNA Center Certificate
for pxGrid check box. You can use this option if all the certificates that are used in your operating environments
must be generated by the same Certificate Authority (CA). If this option is disabled, Cisco DNA Center will
send a request to Cisco ISE to generate a pxGrid client certificate for the system to use.

When you enable this option, ensure that:

• The Cisco DNA Center certificate is generated by the same CA as is in use by Cisco ISE (otherwise the
pxGrid authentication will fail).

• The Certificate Extended Key Use (EKU) field includes “Client Authentication”.

• In the Advanced Settings area:
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• You can choose the protocol that must be used by checking the check box for RADIUS or TACACS

• Enter the required values in the following fields: Authentication Port, Accounting Port, Retries,
and (Timeout seconds).

This option is available only if third-party certificates are used by Cisco DNACenter. If Cisco DNA
Center uses the default self-signed system certificate, this option is disabled.

Note

f) Click Add.

When the integration with Cisco ISE is initiated, you will see a notification that the certificate from Cisco ISE is not yet
trusted. You can view the certificate to see the details.

Click Accept to trust the certificate and continue with the integration process, or choose Decline if you do not wish to
trust the certificate and terminate the integration process.

After the integration completes successfully, a confirmation message is displayed.

If there is any issue in the integration process, an error message is displayed. An option to edit or retry is displayed where
applicable.

• If the error message says that the Cisco ISE Admin credentials are invalid, click Edit and re-enter the correct
information.

• If errors are found with certificates in the integration process, you must delete the Cisco ISE server entry and restart
the integration from the beginning after the certificate issue has been resolved.

Step 3 Verify that Cisco DNA Center is connected to Cisco ISE, and that the Cisco ISE SGT groups and devices are pushed to
Cisco DNA Center:
a) Log in to the Cisco DNA Center GUI.
b) From the top-left corner, click the menu icon and choose System > System 360.
c) In the Identity Services Engine (ISE) pane, verify that the status of all listed ISE servers is displayed as Available

or Configured.
d) In the Identity Services Engine (ISE) pane, click the Update link.
e) From the Authentication and Policy Servers window, verify that the status of the Cisco ISE AAA server is still

Active.

Step 4 Verify that Cisco ISE is connected to Cisco DNA Center and that the connection has subscribers:
a) Log in to the Cisco ISE nodes that are shown as pxGrid servers in the Identity Services Engine (ISE) pane.
b) Choose Administration > pxGrid Services and click the Web Clients tab.

You should see the pxGrid clients in the list with the IP address of the Cisco DNA Center server.

Group-Based Access Control: Policy Data Migration and Synchronization

When You Start Using Cisco DNA Center

In earlier releases of Cisco DNA Center, the Group-Based Access Control policy function stored some policy
Access Contracts and Policies locally in Cisco DNA Center. Cisco DNA Center also propagated that data to
Cisco ISE. Cisco ISE provides the runtime policy services to the network, which includes group-based access
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control policy downloads to the network devices. Usually, the policy information in Cisco DNA Center
matches the policy information in Cisco ISE. But it is possible that the data is not in sync; the data may not
be consistent. Because of this, after installing or upgrading to Cisco DNA Center, the following steps are
necessary before you can use the Group-Based Access Control capabilities.

• Integrate Cisco ISE with Cisco DNA Center, if it is not already integrated.

• Upgrade Cisco ISE, if the version is not the minimum required. See the Cisco DNACenter Release Notes
for the required versions of Cisco ISE.

• Perform Policy Migration and Synchronization.

What Is “Migration and Synchronization”?

Cisco DNA Center reads all the Group-Based Access Control policy data in the integrated Cisco ISE and
compares that data with the policy data in Cisco DNACenter. If you upgraded from an earlier version, existing
policy data is retained. Youmust synchronize the policies before you canmanage Group-Based Access Control
Policy in Cisco DNA Center.

How Does Migration and Synchronization Work?

Usually, the policy data in Cisco ISE and in Cisco DNA Center is consistent, so no special handling or
conversion of data is necessary. Sometimes, when there are minor discrepancies or inconsistencies, only some
of the data is converted during the migration. If there is a conflict, the data in Cisco ISE is given precedence,
so as not to introduce changes in policy behavior in the network. The following list describes the actions taken
during migration:

• Security Groups: The Security Group Tag (SGT), which is a numeric value, uniquely identifies a Security
Group. Cisco ISE Security Groups are compared to Security Groups in Cisco DNA Center.

• When the Name and SGT value are the same, nothing is changed. The information in Cisco DNA
Center is consistent with Cisco ISE and does not need to be changed.

• When a Cisco ISE Security Group SGT value does not exist in Cisco DNA Center, a new Security
Group is created in Cisco DNA Center. The new Security Group is given the default association of
“Default_VN.”

• When a Cisco ISE Security Group SGT value exists in Cisco DNA Center, but the names do not
match, the name from Cisco ISE Security Group replaces the name of that Security Group in Cisco
DNA Center.

• When the Cisco ISE Security Group Name is the same, but the SGT value is different, the Security
Group from Cisco ISE is migrated. It retains the name and tag value, and the Cisco DNA Center
Security Group is renamed. A suffix of “_DNA” is added.

Contracts

All the SGACLs in Cisco ISE that are referenced by policies are compared to Contracts in Cisco DNACenter.

• When the SGACL and Contract have the same name and content, there is no need for further action. The
information in Cisco DNA Center is consistent with Cisco ISE and does not need to be changed.

• When the SGACL and Contract have the same name, but the content is different, the SGACL content
from Cisco ISE is migrated. The previous Contract content in Cisco DNA Center is discarded.

Cisco DNA Center First-Generation Appliance Installation Guide, Release 2.3.7
98

Complete First-Time Setup
Group-Based Access Control: Policy Data Migration and Synchronization



When the SGACL name does not exist in Cisco DNA Center, a new Contract with that name is created, and
the SGACL content from Cisco ISE is migrated.

When creating new Access Contracts based on Cisco ISE SGACL content, Cisco DNA Center parses the text
command lines, and, where possible, renders these SGACL commands as a modeled Access Contract. Each
ACE line renders as an “Advanced” application line. If a Cisco ISE SGACL contains text that cannot be
parsed successfully, the text content of the SGACL is not converted into modeled format. It is stored as raw
command line text. These SGACL text contracts may be edited, but no parsing or syntax checking of the text
content is performed during migration.

Note

Policies

APolicy is uniquely identified by a source group-destination group pair. All Cisco ISE TrustSec Egress Policy
Matrix policies are compared to the policies in Cisco DNA Center.

• When a policy for a source group-destination group references the same SGACL/Contract name in Cisco
ISE, no changes are made.

• When a policy for a source group-destination group references a different SGACL/Contract name in
Cisco ISE, the Cisco ISE Contract name is referenced in the policy. This overwrites the previous Contract
reference in Cisco DNA Center.

• The Cisco ISE default policy is checked and migrated to Cisco DNA Center.

Cisco DNA Center supports a single contract in access policies. Cisco ISE has an option to use multiple
SGACLs in access policies, but this option is not enabled by default in Cisco ISE, and in general is not widely
used. Existing SDA customers who have been using the previous release of Cisco DNA Center to manage
Group-Based Access Control policy did not use this option.

Note

If you enabled the option to allow multiple SGACLs on Cisco ISE and used this when creating policies, those
policies cannot be migrated to Cisco DNA Center in this release. The specific policy features that make use
of the “multiple SGACL” option and cannot be migrated are:

• Multiple SGACLs in a policy.

• Policy Level catch-all rules set to “Permit” or “Deny.” Only the value of “None” is currently supported
for migration to Cisco DNA Center.

• Default Policy set to use a customer-created SGACL, but only the standard values of “Permit IP,”
“Permit_IP_Log,” “Deny IP,” and “Deny_IP_Log” are currently supported for migration to Cisco DNA
Center.

If any of the preceding SGACLs are detected during the policy migration and synchronization operation, a
notification is generated, and you must choose between the following options to continue:

• Manage Group-Based Access Control policy in Cisco DNA Center: If this option is selected, all
management of Group-Based Access Control Policy is done in Cisco DNA Center. The user interface
screens in Cisco ISE for management of Cisco ISE Security Groups, SGACLs, and Egress Policies are
available in Read-Only mode. If there were any issues migrating policies (due to use of multiple SGACLs
in Cisco ISE), those policies have no contract selected in Cisco DNA Center. The policy uses the default
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policy, and you can select a new contract for those policies after completing the migration. If there was
an problem migrating the default policy, the default policy is set to "Permit."

• Manage Group-Based Access Control Policy in Cisco ISE: If this option is selected, Cisco DNA
Center Group-Based Access Control policy management is inactive. No changes are made to Cisco ISE
and there is no effect on policy enforcement in the network. Group-Based Access Control policy is
managed in Cisco ISE at the TrustSec workcenter.

• Manage Group-Based Access Control policy in both Cisco DNA Center and Cisco ISE: This option
is not recommended for general use, because policy changes made in Cisco ISE are not synchronized
with Cisco DNA Center. The two systems cannot be kept in sync. This option is intended as a short-term
or interim option, and should only be considered when you enabled the “AllowMultiple SGACLs” option
in Cisco ISE. Use this option if you need more time and flexibility updating Cisco ISE.

Configure Authentication and Policy Servers
Cisco DNA Center uses AAA servers for user authentication and Cisco ISE for both user authentication and
access control. Use this procedure to configure AAA servers, including Cisco ISE.

Before you begin

• If you are using Cisco ISE to perform both policy and AAA functions, make sure that Cisco DNACenter
and Cisco ISE are integrated.

• If FIPS mode is enabled for Cisco DNACenter, ensure that you enable KeyWrap when integrating Cisco
DNA Center and Cisco ISE. See Step 2e in Integrate Cisco ISE with Cisco DNA Center, on page 94.

You cannot enable KeyWrap if Cisco DNA Center and Cisco ISE have already
been integrated. To enable this feature, you need to delete Cisco ISE and then
reintegrate it with Cisco DNA Center.

Note

• If you are using another product (not Cisco ISE) to performAAA functions, make sure to do the following:

• Register Cisco DNA Center with the AAA server, including defining the shared secret on both the
AAA server and Cisco DNA Center.

• Define an attribute name for Cisco DNA Center on the AAA server.

• For a Cisco DNA Center multihost cluster configuration, define all individual host IP addresses and
the virtual IP address for the multihost cluster on the AAA server.

• Before you configure Cisco ISE, confirm that:

• You have deployed Cisco ISE on your network. For information on supported Cisco ISE versions,
see the Cisco DNA Center Compatibility Matrix. For information on installing Cisco ISE, see the
Cisco Identity Services Engine Install and Upgrade guides.

• If you have a standalone ISE deployment, you must integrate Cisco DNA Center with the Cisco
ISE node and enable the pxGrid service and External RESTful Services (ERS) on that node.
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Although pxGrid 2.0 allows up to four pxGrid nodes in the Cisco ISE deployment,
Cisco DNA Center releases earlier than 2.2.1.x do not support more than two
pxGrid nodes.

Note

• If you have a distributed Cisco ISE deployment:

• You must integrate Cisco DNA Center with the primary policy administration node (PAN),
and enable ERS on the PAN.

We recommend that you use ERS through the PAN. However, for backup, you
can enable ERS on the PSNs.

Note

• You must enable the pxGrid service on one of the Cisco ISE nodes within the distributed
deployment. Although you can choose to do so, you do not have to enable pxGrid on the PAN.
You can enable pxGrid on any Cisco ISE node in your distributed deployment.

• The PSNs that you configure in Cisco ISE to handle TrustSec or SD Access content and PACs
must also be defined in Work Centers > Trustsec > Trustsec Servers > Trustsec AAA
Servers. For more information, see the Cisco Identity Services Engine Administrator Guide.

• You must enable communication between Cisco DNACenter and Cisco ISE on the following ports:
443, 5222, 8910, and 9060.

• The Cisco ISE host on which pxGrid is enabled must be reachable from Cisco DNA Center on the
IP address of the Cisco ISE eth0 interface.

• The Cisco ISE node can reach the fabric underlay network via the appliance's NIC.

• The Cisco ISE admin node certificate must contain the Cisco ISE IP address or FQDN in either the
certificate subject name or the Subject Alternative Name (SAN).

• The Cisco DNACenter system certificate must list both the Cisco DNACenter appliance IP address
and FQDN in the SAN field.

For Cisco ISE 2.4 Patch 13, 2.6 Patch 7, and 2.7 Patch 3, if you are using the
Cisco ISE default self-signed certificate as the pxGrid certificate, Cisco ISEmight
reject that certificate after applying those patches. This is because the older
versions of that certificate have the Netscape Cert Type extension specified as
the SSL server, which now fails (because a client certificate is required).

This issue does not occur in Cisco ISE 3.0 and later. For more information, see
the Cisco ISE Release Notes.

Note

Step 1 From the top-left corner, click the menu icon and choose System > Settings > External Services > Authentication and
Policy Servers.
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Step 2 From the Add drop-down list, choose AAA or ISE.
Step 3 To configure the primary AAA server, enter the following information:

• Server IP Address: IP address of the AAA server.

• Shared Secret: Key for device authentications. The shared secret can contain up to 100 characters.

Step 4 To configure a Cisco ISE server, enter the following details:

• Server IP Address: IP address of the ISE server.

• Shared Secret: Key for device authentications.

• Username: Username that is used to log in to the Cisco ISE CLI.

This user must be a Super Admin.Note

• Password: Password for the Cisco ISE CLI username.

• FQDN: Fully qualified domain name (FQDN) of the Cisco ISE server.

• We recommend that you copy the FQDN that is defined in Cisco ISE (Administration >
Deployment > Deployment Nodes > List) and paste it directly into this field.

• The FQDN that you enter must match the FQDN, Common Name (CN), or Subject Alternative
Name (SAN) defined in the Cisco ISE certificate.

Note

The FQDN consists of two parts, a hostname and the domain name, in the following format:

hostname.domainname.com

For example, the FQDN for a Cisco ISE server can be ise.cisco.com.

• Virtual IP Address(es): Virtual IP address of the load balancer behind which the Cisco ISE policy service nodes
(PSNs) are located. If you have multiple PSN farms behind different load balancers, you can enter a maximum of
six virtual IP addresses.

Step 5 Click Advanced Settings and configure the settings:

• Connect to pxGrid: Check this check box to enable a pxGrid connection.

If you want to use the Cisco DNA Center system certificate as the pxGrid client certificate (sent to Cisco ISE to
authenticate the Cisco DNA Center system as a pxGrid client), check the Use Cisco DNA Center Certificate for
pxGrid check box. You can use this option if all the certificates that are used in your operating environments must
be generated by the same CA. If this option is disabled, Cisco DNA Center will send a request to Cisco ISE to
generate a pxGrid client certificate for the system to use.

When you enable this option, ensure that:

• The Cisco DNA Center certificate is generated by the same Certificate Authority (CA) as is in use by Cisco
ISE (otherwise, the pxGrid authentication fails).

• The Certificate Extended Key Use (EKU) field includes "Client Authentication."

• Protocol: TACACS and RADIUS (the default). You can select both protocols.
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If you do not enable TACAS for a Cisco ISE server here, you cannot configure the Cisco ISE server as
a TACACS server under Design > Network Settings > Network when configuring a AAA server for
network device authentication.

Attention

• Authentication Port: Port used to relay authentication messages to the AAA server. The default UDP port is 1812.

• Accounting Port: Port used to relay important events to the AAA server. The default UDP port is 1813.

• Port: The default TACACS port is 49.

• Retries: Number of times that Cisco DNA Center attempts to connect with the AAA server before abandoning the
attempt to connect. The default number of attempts is 3.

• Timeout: The time period for which the device waits for the AAA server to respond before abandoning the attempt
to connect. The default timeout is 4 seconds.

After the required information is provided, Cisco ISE is integrated with Cisco DNA Center in two phases.
It takes several minutes for the integration to complete. The phase-wise integration status is shown in the
Authentication and Policy Servers window and System 360 window:

Cisco ISE server registration phase:

• Authentication and Policy Servers window: "In Progress"

• System 360 window: "Primary Available"

pxGrid subscriptions registration phase:

• Authentication and Policy Servers window: "Active"

• System 360 window: "Primary Available" and "pxGrid Available"

If the status of the configured Cisco ISE server is shown as "FAILED" due to a password change, click
Retry, and update the password to resynchronize the Cisco ISE connectivity.

Note

Step 6 Click Add.
Step 7 To add a secondary server, repeat the preceding steps.

Configure SNMP Properties
You can configure the retry and timeout values for SNMP.

Before you begin

Only a user with SUPER-ADMIN-ROLE permissions can perform this procedure. For more information, see
the Cisco DNA Center Administrator Guide.

Step 1 From the top-left corner, click the menu icon and choose System > Settings > Device Settings > SNMP.
Step 2 Configure the following fields:

• Retries: Number of attempts allowed to connect to the device. Valid values are from 1 to 3. The default is 3.
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• Timeout (in Seconds): Number of seconds Cisco DNA Center waits when trying to establish a connection with a
device before timing out. Valid values are from 1 to 300 seconds, in intervals of 5 seconds. The default is 5 seconds.

Step 3 Click Save.

To return to the default settings, click Reset and Save.Note
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C H A P T E R 7
Troubleshoot the Deployment

• Troubleshooting Tasks, on page 105
• Log Out, on page 105
• Reconfigure the Appliance Using the Configuration Wizard, on page 106
• Power Cycle the Appliance, on page 107

Troubleshooting Tasks
When troubleshooting issues with the appliance's configuration, you will normally perform the following
tasks:

1. If you are currently using the Cisco DNA Center GUI: Log Out, on page 105.

2. To reconfigure the appliance's hardware, log in to and use the Cisco IMC GUI, as explained in Steps 12
and 13 of Enable Browser Access to Cisco Integrated Management Controller.

3. To change the appliance configuration, launch and use the Maglev Configuration wizard, as explained in
Reconfigure the Appliance Using the Configuration Wizard.

4. Power cycle the appliance so that your changes are active: Power Cycle the Appliance, on page 107.

For more information about the appliance's network adapters, see the Managing Adapters section of the Cisco
UCS C-Series Servers Integrated Management Controller CLI Configuration Guide, Release 3.1. As noted
elsewhere, never attempt to manage the appliance hardware through the Linux CLI. Use only the Cisco IMC
GUI or the Maglev Configuration wizard to change appliance settings.

Log Out
For security reasons, we recommend that you log out after you complete a work session. If you do not log
out yourself, you will be logged out automatically after 30 minutes of inactivity.

To log out of the Cisco DNACenter GUI, from the top-right corner, click your displayed username and choose
Log Out.

This ends your session and logs you out.
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Reconfigure the Appliance Using the Configuration Wizard
To reconfigure an appliance, you must use the Configuration wizard to update the appliance settings. You
cannot use the Linux CLI to do this. The normal Linux administration procedures that you might use to update
configuration settings on a standard Linux server will not work and should not be attempted.

After the appliance is configured, you cannot use the Configuration wizard to change all of the appliance
settings. Changes are restricted to the following settings only:

• Host IP address of the appliance

• DNS server IP addresses

• Default gateway IP address

• NTP server IP addresses

• Cluster Virtual IP address

• Cluster hostname (FQDN)

• Static routes

• Proxy server IP address

• Maglev user password

• Admin user password

Before you begin

You will need the Linux username (maglev) and password that are currently configured on the target appliance.

Step 1 Point your browser to the Cisco IMC IP address you set during the Cisco IMC GUI configuration you performed, and
log in to the Cisco IMC GUI as the Cisco IMC user (see Enable Browser Access to Cisco Integrated Management
Controller).
After successful login, the appliance displays theCisco Integrated Management Controller Chassis Summarywindow,
with a hyperlinked menu at the top of the window, as shown below.

Step 2 From the hyperlinked menu, choose Launch KVM and then select either Java based KVM or HTML based KVM. If
you select Java-based KVM, you will need to launch the Java startup file from your browser or file manager in order
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to view the KVM console in its own window. If you select HMTL-based KVM, it launches the KVM console in a
separate window or tab automatically.

Irrespective of the KVM type you choose, use the KVM console to monitor the progress of the configuration and respond
to the Maglev Configuration wizard prompts.

Step 3 When prompted, enter the Linux password.
Step 4 Enter the following command to access the Configuration wizard.

sudo maglev-config update

If you are prompted for the Linux password, enter it again.

Step 5 The Configuration wizard presents an abbreviated version of the same series of screens shown in, for example, Configure
a Secondary Node. Make changes to the settings presented, if required. After you finish making changes on each screen,
choose [Next], as needed, to proceed through the Configuration wizard.

Step 6 At the end of the configuration process, a message appears, stating that the Configuration wizard is now ready to apply
your changes. The following options are available:

• [back]: Review and verify your changes.

• [cancel]: Discard your changes and exit the Configuration wizard.

• [proceed]: Save your changes and begin applying them.

Choose proceed>> to complete the installation. The Configuration wizard applies the changes you made.

At the end of the configuration process, a CONFIGURATION SUCCEEDED! message appears.

Power Cycle the Appliance
Complete one of the following procedures on your Cisco DNA Center appliance to either halt it or perform
a warm restart. You can halt the appliance before you make hardware repairs, or you can initiate a warm
restart after you have corrected software issues.

Using the Cisco IMC GUI
If you want to use the KVM console that is accessible from the Cisco IMCGUI in order to halt your appliance
or perform a warm restart, complete the tasks described in this procedure.

Before you begin

Note that any hardware changes you make using the Cisco IMC GUI will be applied after the appliance
reboots.

Power cycling your appliance from the Cisco IMC GUI can result in the corruption or loss of data. Only do
so if your appliance is completely unresponsive to SSH, the Cisco IMC console, or the physical console.

Caution
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Step 1 Point your browser to the Cisco IMC IP address you set during the Cisco IMC GUI configuration you performed, and
log in to the Cisco IMC GUI as the Cisco IMC user (see Enable Browser Access to Cisco Integrated Management
Controller, on page 43).

After successful login, the appliance displays theCisco Integrated Management Controller Chassis Summarywindow,
with a hyperlinked menu at the top of the window, as shown below.

Step 2 With the KVM displayed, reboot the appliance by choosing Host Power > Power Cycle.

If you are asked to confirm your choice to reboot the appliance, click OK.

Using SSH
If you want to use SSH in order to halt your appliance or perform a warm restart, complete the following
tasks:

Before you begin

You will need the following:

• Secure Shell (SSH) client software.

• The IP address that you configured for the 10-Gbps Enterprise port on the appliance that needs
reconfiguration. Log in to the appliance at this address, on port 2222.

To identify the Enterprise port, see the rear-panel figure in Front and Rear Panels, on page 2.

• The Linux username (maglev) and the password that is currently configured on the target appliance.

Step 1 Using a Secure Shell (SSH) client, log in to the IP address of the Enterprise port of the appliance that needs to be
reconfigured, on port 2222:

ssh maglev@Enterprise-port's-IP-address -p 2222

Step 2 When prompted, enter the Linux password.
Step 3 Enter the command that is appropriate for the task you want to perform:
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• To halt the appliance, enter: sudo shutdown -h now

• To initiate a warm restart, enter: sudo shutdown -r now

If you are prompted for the Linux password, enter it again.

Step 4 Review the command output that is displayed as the host shuts down.
Step 5 If you halted your appliance, power up the Maglev root process by turning the appliance back on, using the front-panel

power button.
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A P P E N D I X A
Review High Availability Cluster Deployment
Scenarios

Cisco DNA Center's implementation of high availability (HA) is described in the Cisco DNA Center High
Availability Guide. We recommend that you first review this information and then determine whether you
want to deploy HA in your production environment. If you choose to do so, complete the following tasks:

1. Complete the deployment procedure that is appropriate for your network:

• New HA Deployment

• Existing HA Deployment of the Primary Node with Standard Interface Configurations

• Existing HA Deployment of the Primary Node with Nonstandard Interface Configurations

2. Activate HA on your Cisco DNA Center cluster.

3. See Additional HADeployment Considerations andmake any additional configurations that are necessary.

• New HA Deployment, on page 111
• Existing HA Deployment of the Primary Node with Standard Interface Configurations, on page 112
• Existing HA Deployment of the Primary Node with Nonstandard Interface Configurations, on page 112
• Activate HA, on page 113
• Additional HA Deployment Considerations, on page 113

New HA Deployment
To install a brand new HA cluster, complete the following steps:

Step 1 Configure the first installed appliance as the primary node.

See Configure the Primary Node.

Step 2 Configure the second and third appliances in the cluster.

See Configure a Secondary Node.
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Existing HA Deployment of the Primary Node with Standard
Interface Configurations

To deploy an existing HA cluster, where the primary node uses the required interface cable configurations,
complete the following steps.

Step 1 Upgrade the primary node to the latest Cisco DNA Center version.

For information about upgrading your current release of Cisco DNA Center, see the Cisco DNA Center Upgrade Guide.

Step 2 Confirm that you are using the required interface cable configurations on the primary node.

See Interface Cable Connections.

Step 3 Update the virtual IP address (if the virtual IP address is not yet added).

See Reconfigure the Appliance Using the Configuration Wizard.

Step 4 Configure the second and third appliances in the cluster.

See Configure a Secondary Node.

Step 5 Enter the following command to check the GlusterFS size:

sudo du -h /data/maglev/srv/maglev-system/glusterfs/mnt/bricks/default_brick/ | tail -1 | awk '{print $1}'

If the GlusterFS file system size is larger than 150 GB, complete the steps described in Existing HA Deployment of the
Primary Node with Nonstandard Interface Configurations.

Existing HA Deployment of the Primary Node with Nonstandard
Interface Configurations

To deploy an existing HA cluster where the primary node uses nonstandard interface configurations, complete
the following steps.

Step 1 Upgrade the primary node to the latest Cisco DNA Center version.

For information about upgrading your current release of Cisco DNA Center, see the Cisco DNA Center Upgrade Guide.

Step 2 Create a backup of the remote repository.

See the "Backup and Restore" chapter in the Cisco DNA Center Administrator Guide.

Step 3 Reimage the primary node with the required interface cable configuration.

See Interface Cable Connections and Install the Cisco DNACenter ISO Image.Make sure that the VIP has been configured
correctly on the primary node.
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Step 4 On the primary node, install the same set of packages that you selected during the backup.
Step 5 Using the backup file that you created in Step 2, restore the remote repository's data.
Step 6 Configure the second and third appliances in the cluster.

See Configure a Secondary Node.

Activate HA
Cisco DNA Center's implementation of HA is described in the Cisco DNA Center High Availability Guide.
We recommend that you first review this information and then determine whether you want to deploy HA in
your production environment. If you choose to do so, complete the following steps:

1. From the top-left corner, click the menu icon and choose System > Settings > System Configuration >
High Availability.

2. Click Activate High Availability.

After you click Activate High Availability, Cisco DNA Center enters into maintenance mode. In this mode,
Cisco DNA Center is unavailable until the redistribution of services is completed. You should take this into
account when scheduling an HA deployment.

Cisco DNACenter goes into maintenancemode every time you restore the database, perform a system upgrade
(not a package upgrade), and activate HA (as described above).

Note

Additional HA Deployment Considerations
For an existing HA deployment, the following additional configurations must be made.

Telemetry
If you enabled telemetry for a device (without enabling the VIP), complete the following steps:

Step 1 Use the sudo maglev-config update command to update the cluster VIP.
Step 2 Disable telemetry on the device:

a. From the Cisco DNA Center home page, choose Network Telemetry from the Tools area.

The Network Telemetry window appears.

b. Click the Site View tab.

c. Check the check box of the device on which you want to disable telemetry, and then choose Actions > Disable
Telemetry.
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Step 3 Reenable telemetry using the profile associated with the device previously.

Wireless Controller
You must update the wireless controllers in your network with the new VIP of Cisco DNA Center.
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